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About This Document

What’s in This Document

This user’s guide contains all of the procedures and reference material you need 
to use the Avaya Softconsole  Release 1 in your unique environment.

■ Chapter 1, “Getting Started” provides an overview of the Softconsole 
functions and window, and describes the window components. This 
chapter also contains the procedures you need to access Softconsole 
operations and to customize the Softconsole window.

■ Chapter 2, “Using the Softconsole Directories” contains an overview of the 
Softconsole directory functions, as well as instructions to search, call, and 
update information for any person listed in a Softconsole directory. It also 
includes procedures for sending email from the directory. 

■ Chapter 3, “Handling Calls with Softconsole” contains an overview of 
Softconsole call handling operations, as well as complete instructions to 
answer, place, hold, transfer, conference, and release calls. It also includes 
instructions for typing notes while you are active on a call.

■ Chapter 4, “Troubleshooting” contains procedures to help you resolve 
problems and respond to error messages that you may encounter while 
using Softconsole.

A glossary is provided at the back of this guide.
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Conventions Used in This Manual

The following conventions are used in this manual:

■ The keyboard or the mouse can be used to accomplish most tasks in 
Softconsole. 

■ Information in bold type characters, such as F9 (Release), represents a 
keyboard option, button, or indicator on the Softconsole window.

■ In many instances, you can make a selection or perform a specific task by 
pressing ALT and the underlined character of a selection. For example, 
pressing ALT-D when the focus is on the directory display area allows you 
to select the Directory menu.

Related Documentation

To understand the material in this document, you must already be familiar with 
your computer, standard electronic mail tools, and with Microsoft® Windows®. 
(If this is not the case, consult your system administrator, then continue with your 
Softconsole training.) This document provides all the information you need to use 
your new Softconsole efficiently. In addition, you can refer to the following 
documents:

■ Avaya Softconsole  Release 1.0 Quick Reference - As you become more 
familiar with Softconsole, you can refer to this booklet that contains 
summaries of the commands and procedures you will use most frequently 
during a Softconsole session.

■ Avaya Softconsole Release  1.0 Attendant System Features - This manual 
contains brief descriptions of attendant system (call-handling) features, as 
well as procedures for using these features in your unique environment. 
Such features include Abbreviated Dialing, Attendant Call Waiting, Call 
Forwarding, Loudspeaker Paging, etc.

How To Get Help

If you have a question about Softconsole, first read this guide or refer to the online 
help. If you cannot find the answer, contact your Softconsole administrator.



Issue  1   March 2002 1-1 

1
Getting Started

Welcome

Congratulations on your purchase of the Avaya Softconsole — the integrated 
solution that enables you to handle calls and communicate with the members of 
your organization and your business contacts directly from your computer.

Softconsole offers all of the capabilities of a hardware attendant console, plus the 
ability to share information across your organization, customize your screen 
displays, and manage your call-handling tasks quickly and efficiently.

This chapter provides an overview of Softconsole’s capabilities. It is intended to 
introduce the new user to basic Softconsole concepts. As you become more 
familiar with this all-in-one tool, you can refer to the Avaya Softconsole 

Release 1.0 Quick Reference.

An Overview of Softconsole

Softconsole allows you to:

■ Customize the application window and save your preferences; for example, 
rearrange toolbars and feature buttons, as well as choose the tones that 
you hear as you work at the Softconsole.

■ Resize the Softconsole window and its components (including Busy Lamp 
Field, directory, and call appearance areas simultaneously) to show as 
much information as you need when you need it.

■ Complete call handling quickly with only a few keystrokes.

■ Check the status of any extension in your environment instantly.
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■ Locate business associates and colleagues--at your site or remote 
locations--by searching through the administered directories via 
Softconsole. 

■ Place a call directly to a found entry in the Softconsole directory.

■ Send email while you are working in Softconsole.

■ Access online help information immediately.

Each of these capabilities is discussed in this guide.

System Environments Affecting 
Softconsole Operation

Softconsole is designed to operate in several system environments, including 
Distributed Communications Systems (DCS) and Centralized Attendant Service 
(CAS) configurations. The DCS and CAS configurations are used at organizations 
that have more than one Avaya call processing system and may be located at 
different geographical locations. These system environments are described 
below.

Your Softconsole administrator can tell you whether your organization uses one of 
these configurations. If so, some Softconsole features may be affected. In most 
cases, the impact is minimal. For example, a display color may vary from the 
standard color indicated in this guide or a tone may be delayed. If you must follow 
any procedures specific to your system environment, you will see a note directing 
you to the appropriate procedure.

The DCS Environment

A DCS configuration consists of 2 to 20 private call processing systems that are 
interconnected. These switches may reside in different geographical locations. To 
certain Softconsole features, however, the DCS configurations appears as a 
single switch. These features include:

■ Attendant Call Waiting

■ Attendant Control of Trunk Group Access

■ Attendant Display

■ Automatic Circuit Assurance

■ Busy Verification of Telephones and Trunks

■ Call Forwarding All Calls

■ Direct Trunk Group Selection

■ Trunk Group Busy/Warning Indicators
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Refer to the Avaya Softconsole  Release 1.0 Attendant System Features Guide 
for a description of each of these features and the impact that your system 
environment may have on them.

The CAS Environment

In the CAS environment, system users served by separate call processing 
systems at two or more locations can concentrate the attendant positions at one 
location. This location is called the CAS main. The other locations, typically 
without attendants, are called CAS branches. All locations within the CAS 
environment have separate LDNs.

Incoming calls to the CAS main are handled as if the call processing system were 
a standalone system. Any attendant-seeking calls at a CAS branch are routed to 
the attendant consoles at the CAS main over Release Line Trunks (RLTs). The 
RLTs are special trunks that are used only for attendant-seeking calls from the 
CAS branches. The CAS attendant cannot originate a call over an RLT.

CAS calls are any calls that would usually go to the local attendant console. As 
the CAS attendant, you answer these calls and then transfer them (over the same 
RLT) to the requested extension or external telephone number at the branch. 
When you release the call, the RLT is free to accept another call. The transferred 
call will return to a CAS console if it is not answered within a predetermined time. 
Similarly, any CAS calls placed on Hold or Remote Hold also return to a CAS 
console if they are not answered within a predetermined time.

The following features and procedures are affected by the CAS environment:

■ Attendant displays and audible alerts (tones)

■ Answering calls

■ Dialing methods

■ Placing calls on Hold and Remote Hold

■ Transferring calls to the originating branch and to other branches

These differences in feature operation and procedures are discussed throughout 
this guide. In addition, refer to the Avaya Softconsole  Release 1.0 Attendant 
System Features Guide for more information about the impact that your system 
environment may have on specific features of Softconsole.
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An Overview of the Softconsole 
Window

Softconsole consolidates the tools you may already use, including your telephone 
system hardware console for call handling, and your personal computer for email 
and online personnel directory information. With Softconsole, you can now access 
any of these tools with a keystroke or click of the mouse at your computer.

When you first log into a Softconsole session, you see the Softconsole window 
with the standard (default) appearance. A sample is shown in Figure 1-1. Notice 
that this display resembles typical commercial applications, such as Microsoft 
Outlook®, including the menu bar and toolbars that operate in the same way. And 
you can rearrange and resize the Softconsole window components just as you 
would any standard office applications.

Figure 1-1. Standard Softconsole Window Display

Table 1-1 identifies the components shown in the standard Softconsole window.
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The following sections explain the Softconsole window components in more 
detail.

Table 1-1. The Softconsole Window Components

Feature Description

1. Menu bar Provides File, View, Action, Trunks, Display, 
Features, Directory, and Help options. 
To get immediate online help, press F1.

2. Toolbar area Contains directory, trunk, and control toolbars and 
administered display buttons. Depending on the 
configuration, this area may contain CallMaster VI or 
IP volume control, and IP control toolbars.

3. Directory panel Contains a vertical display of icons that correspond to 
directories available to you. 

4. Directory display Displays entries for the active directory with the 
selected entry highlighted.

5. Call appearance 
area

Displays call appearances with information about 
each call, which can include call identifier text, call 
state and timer, Second Party name field, an 
information button, and a comment area.

6. Action toolbar Displays the buttons corresponding to the call 
handling options available to you on the current call, 
such as Transfer, Hold, Release, etc.

Note: If you already use PC Console, you should 
read the description of the Action toolbar buttons (see 
Chapter 3) carefully. Some buttons and call handling 
procedures provided by Softconsole differ from those 
you use with PC Console.

7. Status bar Provides feedback information at a glance, including 
alarms and an attendant queue indicator.

8. Feature buttons Correspond to the administered feature buttons on a 
hardware console.

9. Direct Extension 
Select/Busy 
Lamp Field 
(DXS/BLF)

Corresponds to the same area on a hardware 
console. Each administered hundreds group 
occupies a tab. Each tab contains 100 cells that 
correspond to an administered extension.
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Using the Softconsole Menu Bar

The Softconsole menu options are described below. 

NOTE:
Note that you can open each menu by pressing ALT and the appropriate 
letter key. For example, ALT-F opens the File menu.

Using the File Menu (ALT-F)

The File menu provides these options:

■ Exit - If your Softconsole administrator has not defined individual user 
profiles, you must select this option to end your Softconsole session.

■ Logoff - If your Softconsole administrator has defined individual user 
profiles, you must select this option to end your Softconsole session. (This 
option appears only when user profiles are defined.)

■ IP Login - If you are working in an IP configuration, this option appears on 
the File menu. You can access the server and begin your Softconsole 
session via this option. Its submenu allows you to disconnect from the 
server, as well as adjust IP registration settings.

Using the View Menu (ALT-V)

The View menu allows you to view a list of available toolbars and feature buttons. 
When a checkmark appears before an option, the option (for example, the Busy 
Lamp Field, dialpad, or display messages) appear in the Softconsole window. 
When you click on a marked option, you disable it. 

The System Settings option allows you to enable and disable the Auto Transfer 
feature. (When Auto Transfer is enabled, you can transfer an incoming call to an 
extension automatically without announcing it.) You can also select the setting for 
Second Party Display Handling with this menu option.

The TAPI Configuration option allows you to update area codes and required 
access codes that you need for making long-distance calls. See Chapter 4 for 
more information.

NOTE:
The Debug feature available from the System Settings option is a tool for 
solving problems with Softconsole. It is reserved for use by your Softconsole 
administrator and Avaya Technical Support personnel only.



Using the Softconsole Menu Bar

Issue  1   March 2002 1-7

If you make changes to the Softconsole window, you can save the changes, 
restore the standard (default) view, or restore the saved view using options on the 
View menu. In addition, View menu options allow users in IP configurations to 
select recording and playback devices, and to adjust the volume of the 
microphone, headset, or speakers that they may be using with Softconsole.

Using the Action Menu (ALT-O)

The Action menu contains the options that correspond to the call handling buttons 
displayed in the Action toolbar. The accelerator keys and function keys associated 
with each option are also displayed on this menu.

Using the Trunks Menu (ALT-T)

The Trunks menu allows you to view all the administered buttons displayed on the 
Trunk button toolbar. 

Using the Display Menu (ALT-P)

The Display menu allows you to view the administered buttons that appear along 
with an associated Help Tip on the Display button toolbar. 

Using the Features Menu (ALT-A)

The Features menu lists all of the administered feature buttons in alphabetical 
order, along with their associated accelerator keys. Depending on your 
configuration, these feature buttons (for example, Night Service and Position 
Busy) are displayed on the Softconsole window. 

Using the Directory Menu (ALT-D)

The Directory menu allows you to view a list of directories available to you. (Note 
that these directories are also shown in the directory panel.) The currently active 
directory is indicated by a checkmark. In addition, the activities you can perform 
while you are working in an active directory are displayed on this menu. These 
activities include adding an entry, modifying an entry, viewing an entry, showing a 
detailed view of entries, deleting an entry, and sending email. For more 
information, see “Using the Directory Display Areas,” later in this chapter.

Using the Help Menu (ALT-H)

The Help menu allows you to access online help. You can also get immediate 
online help by pressing F1. 
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Using the Directory Display Areas

Softconsole can support several directories. The icons representing each of the 
directories available to you are displayed in the directory panel (a vertical list on 
the left side of the Softconsole window). One of these directories is the default 
directory, which is used to identify the called or calling parties and to display that 
information in the Second Party Display. The default directory is also used to 
identify the user name associated with each extension in the Busy Lamp Field.

You can access directories by clicking on a specific directory icon, accessing the 
Directory menu and pressing the corresponding letter key, or selecting a directory 
name from the Directory menu.

The entries for the selected directory appear in the directory display area. 
Typically an entry consists of an individual’s first name, last name, and phone 
number. An entry may also include the individual’s organization and email 
address. Using the vertical scroll bar on the right side of this display area, you can 
move up and down through the displayed directory entries. 

While you are working in this area of the Softconsole window, you can perform 
several activities. For example, you can make calls or send email to a selected 
directory entry. You can also add new entries, make notes associated with a 
selected directory entry, and view and edit the information associated with a 
selected directory entry by using the directory toolbar. You can also search for a 
specific individual in the directory and view the line status for the extension 
associated with a selected entry by clicking ALT-S. (The background color of the 
directory entry displayed changes to reflect the color in the BLF cell corresponding 
to this extension.) See Chapter 2 for detailed information and procedures.
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Using the DXS/BLF Display

This area of the Softconsole window corresponds to the same area on a hardware 
console. From this area, you can select a Hundreds Group tab and:

■ Left-click on a cell to dial its associated extension. 

NOTE:
Busy extensions appear in dark blue, and idle extensions appear in light 
blue. Amber indicates the called extension is idle but has its Send All Calls 
(SAC) feature enabled. If you are working in a DCS environment or an 
environment in which the CAS feature is enabled, keep in mind that the 
Busy Lamp Fields do not indicate busy extension numbers at the branch 
locations.

■ Right-click on a cell, and a dialog box opens displaying the name of the 
person at the extension and any notes related to this directory entry. 

Using the Call Handling Area

You use this area of the Softconsole window to answer, place, hold, transfer, 
conference, and release calls. You can also make comments while active on a 
call, monitor calls in the queue, and respond to alarms. See Chapter 3 for detailed 
information and procedures.

Using the Call Appearances

There are six call appearances in the Softconsole window. Each call appearance 
provided displays information about a call that you are currently handling. 

Figure 1-2. Sample Call Appearance

Table 1-2 identifies the components shown in the sample call appearance.

3 4 5 6 721
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Using the Action Toolbar

While you are active on a call, several buttons associated with the call handling 
functions available to you appear on the Action toolbar below the call appearance 
area. These functions can include New, Pickup, Transfer, Conference, Add (which 
is available when Conference is enabled), Hold, Release, Cancel, and Drop All. 
Complete call handling procedures are provided in Chapter 3.

Table 1-2. Call Appearance Components

Feature Description

1. Call state icon 
and timer

Indicates the duration and call state of the active call. 
If you put a call on hold, this call timer is reset to 
reflect the length of time (indicated in minutes and 
seconds) the call remains held at the console.

2. Call processing 
system 
information

Displays text sent from the call processing system to 
identify the call. For example, “Outside call to Mary 
LaFemme at EXT. 3062.”

3. Call purpose Displays text identifying the call’s purpose. For 
example, “Called extension SAC on.”

4. Second party 
name

If the Second Party Display is set to “Originator,” the 
calling party name is displayed. If it is set to 
“Coverage Point,” the called party name is displayed.

5. More information 
button

Click on this button (or press ALT-I) to view a 
complete directory record.

6. Second party 
notes

If notes are saved in the directory for this extension 
(for example, “On vacation from May 3 to May 10.”), 
they are displayed.

7. Comment area Allows you to enter comments about the call while the 
call is active (and the field appears white). These 
comments remain only for the duration of the call. 
See Chapter 3 for detailed information and 
procedures.



Using the Feature Buttons

Issue  1   March 2002 1-11

Using the Feature Buttons

The feature buttons displayed in two columns on the right side of the Softconsole 
window correspond to the feature buttons on a hardware console. Five feature 
buttons are administered on every Softconsole — Split, Hold, Forced Release, 
Position Busy, and Night Service. Your Softconsole administrator can assign the 
remaining buttons as optional feature buttons to give you access to the various 
call processing system features.

The short name assigned to every feature button administered for Softconsole is 
displayed. To get a longer description of any feature button, position the cursor 
over the button. If administered, a Help Tip box containing a description of that 
button is displayed.

NOTE:
If you are denied access to a particular feature, the associated button turns 
pink (the equivalent of flashing on a hardware console).

Using the Display Buttons

Display buttons appear on the Display control toolbar. The short name assigned 
to every display button administered for Softconsole. To get a longer description of 
any display button, position your cursor over the button. If administered, a Help 
Tip box containing a description of that button is displayed.

Display buttons are used in exactly the same manner as display buttons on a 
telephone or hardware console. Click the button to perform a particular task. For 
example, if you are using the call processing system’s Integrated Directory 
feature, clicking the Next button advances to the next entry in the list. 

Using the Trunk Buttons

Trunk Group buttons appear on the left side of the control toolbar. You can place a 
call on a specific trunk by selecting its corresponding button and dialing the 
telephone number. Note that these buttons reflect trunk status, including:

■ Trunk Group in use - This state is indicated when at least one trunk in the 
group is in use.

■ Trunk Group warning - This state is indicated when the number of trunks in 
the group in use has reached a threshold administered at the call 
processing system.

■ Attendant control - This state is indicated when you have taken control of 
the Trunk Group. When the trunk is under attendant control, all outgoing 
calls placed on the trunk are diverted to you.
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Viewing the Status Bar

The bottom portion of the window contains the Status bar. It provides feedback 
information. 

■ The Display box is located on the left side of the Status bar. By default, it 
reminds you to press F1 to get online help. As you move the cursor over 
particular elements of the Softconsole window, the corresponding Help Tip 
is also shown in the Display box.

■ The attendant queue indicator (AQI) is located to the right of the Display 
box. The purpose of the indicator is to keep you informed of how many 
calls are waiting. It also displays the number of minutes and seconds that 
the oldest call has been waiting.

If administered, the AQI may also reflect the number of waiting calls with an 
advancing bar display. The color of the advancing bar is dark blue. 
However, if the Call Waiting Warning lamp is enabled, the color changes to 
amber.

The Status bar can also display indicators that correspond to status lamps 
controlled by the call processing system:

■ Alarm indicates a system problem has been detected.

■ Alarm Reported indicates that the system has alerted the maintenance 
organization of the detected problem.

NOTE:
See Chapter 4 for information on responding to alarms.

■ Individual Calls indicates that one or more calls directed to your personal 
extension (not the “0” extension) are waiting.

■ Position Available indicates that your position is available to receive calls.

In addition, a Link down indicator may appear to alert you that the connection 
between Softconsole and the call processing system has been disconnected.
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Using “Shortcut” Keys

As a convenience for attendants who perform most call handling and directory 
activities using the computer keyboard, Softconsole has several programmed “hot 
keys” and accelerator key sequences. By pressing ALT simultaneously with an 
appropriate accelerator key, you can perform many tasks with a minimum number 
of keystrokes. For example, by pressing ALT-D you can access the Directory 
menu.

Table 2 summarizes the operation of shortcut keys (including function key 
equivalents) within the various areas of the Softconsole window.

Table 1-3. Shortcut Keys

NOTE:
Feature and display buttons, as well as individual directories and Trunk 
control toolbar, may have been assigned “shortcuts” by your Softconsole 
administrator.

Area Press ALT To access

Main Menu F
V
O
T
P
A
D

File menu
View menu
Action menu
Trunks menu
Display menu
Features menu
Directory menu

Action Menu N (or F3)
P (or F4)
T (or F5)
C (or F6)
(F7)
H (or F8)
C (or F10)
D (or F11)

New call
Pick up a call
Transfer a call
Conference a call
Add a call to a conference
Hold a call
Cancel 
End a conference call

Call Appearances 1 through 6 Call appearances 1 through 6. 

Directory Menu

Note: Press ALT-D to 
access the Directory 
menu first. Then, use 
the shortcut key listed.

A
E
V
D
M

ALT-S

Add an entry.
Edit an entry.
View an entry.
Delete an entry.
Send email. (You do not have to 
access the Directory menu first to 
use this shortcut.)
Show a detailed view.
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Customizing the Softconsole Interface

You can change the Softconsole interface to reflect your personal preferences. 
The changes you make can be saved so that you see them each time you log into 
a Softconsole session.

Changing the Softconsole Window Appearance

You can change the size of the Softconsole window in the same way that you do 
typical Windows application windows. In addition to changing the size and 
placement of the entire window, you can rearrange and resize of individual 
window components.

■ Call appearance area - You can change the size of this area vertically and 
horizontally by clicking on the appropriate border and dragging it to an 
allowable size.

■ DXS/BLF - You can resize the DXS/BLF area horizontally to make it 
narrower or wider by clicking on and dragging the vertical bar that borders 
the DXS/BLF and the directory display areas.

You can also hide the DXS/BLF display by selecting the Busy Lamp Field 
option on the View menu.

■ Dialpad - You can click on the dialpad display and drag it to another area 
(including outside the application window). You can also hide the dialpad 
display by selecting the Dialpad Toolbar option on the View menu.

■ Toolbars - You can relocate the console display, display and feature 
toolbars, Trunk control bar, and Directory toolbar. You can even move them 
to a location outside the application window.

■ Display box text - You can turn off the display of messages in the Display 
box on the left side of the Status bar. To do so, select the Display 
messages option on the View menu.

Your changes are saved automatically when you exit your Softconsole session. If 
you do not want these changes saved, select the Restore default view option on 
the View menu to return the Softconsole window to its default appearance.

If other attendants use your Softconsole computer, before you exit your 
Softconsole session, select the Save current view option on the View menu to 
save your preferences in your login profile. The saved window appearance will be 
restored when you log into Softconsole again.

NOTE:
If you are not required to log into Softconsole, the last saved window 
appearance is presented when you begin your Softconsole session. 
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Changing Predefined System Settings

You can change certain Softconsole settings that the Softconsole administrator 
has programmed. If an individual user profile has been defined for you, 
Softconsole automatically saves these changes so that you see them each time 
you log in:

■ Auto Transfer — To disable this feature so that you can announce calls 
before transferring them, select the System Settings option on the View 
menu. In the dialog box that opens, set the Auto Transfer feature to “Off.” 
Then, click OK.

■ Second Party Display Handling — If the Second Party Display is set to 
“Originator,” the calling party name is displayed in the area of the call 
appearance. If it is set to “Coverage Point,” the called party name is 
displayed. To change the current setting, select the System Settings option 
on the View menu. In the dialog box that opens, select the appropriate 
setting for Second Party Display Handling. Then, click OK.

Adjusting Audio Components

Depending on your Softconsole configuration, you can adjust the volume and 
audio quality of headsets, microphones, and speakers used at the Softconsole 
computer.

Volume Control for DCP Installations 
(CallMaster VI)

If you are using a CallMaster VI system, you see an additional toolbar on the 
Softconsole window. This toolbar contains a “slidebar” control that allows you to 
adjust the volume of your Softconsole. You can choose from eight settings, and 
the setting you prefer can be saved in the Softconsole. 

Volume Control for IP Configurations

If you are working in an IP configuration, you can adjust the volume and verify the 
operation of the headset using the Audio Options or Tuning Wizard. You can 
access these options using the Audio option on the View menu or the Audio 
Control toolbar and the Audio Setting toolbar.

Audio Control Toolbar

The Audio Control Toolbar enables you to

■ mute your microphone

■ access the Audio Monitor dialog box, which displays audio status 
information

■ mute the speaker in your headset
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Figure 1-3 shows the Audio Control toolbar.

Figure 1-3. Audio Control Toolbar

NOTE:
The Audio Control toolbar is only enabled when you use Avaya Softconsole 
in IP mode in the Road Warrior configuration (that is, voice over IP mode). 

Audio Setting Toolbar

The Audio Setting Toolbar enables you to

■ modify the audio options for Avaya iClarity IP Audio

■ mute the speakers of the headset

■ adjust the volume of the speakers

■ specify whether you want to hear your voice in your headset

■ mute the microphone of the headset

■ adjust the volume of the microphone

■ mute the ringer

■ adjust the ringer volume

■ specify whether you want the ringer to play through the internal PC speaker

■ run the Tuning Wizard, which helps you configure Avaya iClarity IP Audio

Figure 1-4 shows the Audio Setting toolbar.

Figure 1-4. Audio Setting Toolbar

NOTE:
The Audio Control toolbar is only enabled when you use Avaya Softconsole 
in IP mode in the Road Warrior configuration (that is, voice over IP mode).
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Mute the Microphone

To mute the microphone of the headset:

1. Make sure the microphone is on.

2. Click the Microphone button on the Audio Control toolbar.

The microphone is muted.

To turn off the Mute feature, click the Microphone button again.

Adjust the Microphone Volume

To adjust the microphone volume of the headset:

1. Make sure the microphone is on.

2. Click the Volume button on the Audio Setting toolbar.

The Volume and Ringer Settings dialog box appears.

3. In the Record area, move the slider to adjust the volume of the 
microphone. (Moving the slider to the right increases the volume of the 
microphone.)

4. Click the Close button.

Mute the Speakers

To mute the speakers (that is, the headset):

1. Make sure the speakers are on.

2. Click the Speaker button on the Audio Control toolbar.

The speakers are muted.

To turn off the Mute feature, click the Speaker button again.

Adjust the Speaker Volume

To adjust the volume of the speakers (that is, the headset):

1. Make sure the speakers are on.

2. Click the Volume Settings button on the toolbar.

The Volume and Ringer Settings dialog box appears.

3. In the Playback area, move the slider to adjust the volume of the speakers. 
(Moving the slider to the right increases the volume of the speakers.)

4. Click the Close button.
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Mute the Ringer

To mute the ringer for incoming calls:

1. Click the Volume button on the Audio Setting toolbar.

The Volume and Ringer Settings dialog box appears.

2. In the Ringer area, click the Mute check box.

3. Click the Close button.

Adjust the Ringer Volume

To adjust the ringer volume for incoming calls:

1. Click the Volume button on the Audio Setting toolbar.

The Volume and Ringer Settings dialog box appears.

2. In the Ringer area, move the slider to adjust the volume of the ringer. 
(Moving the slider to the right increases the volume of the ringer.)

3. Click the Close button.

Play Ringing Through the Internal PC Speaker

To play ringing through the internal speaker of the PC:

1. Click the Volume button on the Audio Setting toolbar.

The Volume and Ringer Settings dialog box appears.

2. In the Ringer area, click the Also play ringing through the internal PC 
speaker check box.

3. Click the Close button.

Hear Your Voice in Your Headset when You Speak

To hear your voice in your headset when you speak:

1. Click the Volume button on the Audio Setting toolbar.

The Volume and Ringer Settings dialog box appears.

2. In the Playback area, click the Hear my voice in the headset check box.

3. Click the Close button.
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Accessing Softconsole 

The following procedures explain how to access and exit a Softconsole session. 
The procedure you use depends on how your Softconsole is configured. Your 
Softconsole administrator is responsible for giving you a login name and 
password (if these are required). 

The information that you enter in the Login dialog box depends on whether your 
Softconsole administrator has defined individual user profiles for attendants. If an 
individual user profile has not been defined for you, you must log into Softconsole 
using the default (universal) login information supplied by your system 
administrator to all attendants.

Starting a Softconsole Session

To start a Softconsole session:

1. At your Desktop window, double-click on the Softconsole icon.

If you are not required to enter a login name or password, the Softconsole 
window opens. Otherwise, proceed to Step 2.

2. Enter your login name and password (if applicable).

3. Press ENTER, or click OK.

NOTE:
If you are working in an IP configuration, you must also log into the server 
before you can use Softconsole. See “Logging into IP Configurations.”

Identifying Yourself to Softconsole

If another attendant has been working in a Softconsole session at your computer, 
you must identify yourself to Softconsole before you can begin your session.

To identify yourself to Softconsole:

1. From the File menu, click Change Attendant to display the login dialog 
box.

2. Enter your login name and password.

3. Press ENTER, or click OK.

NOTE:
You can make up to three attempts to enter the correct login 
information. If you have any difficulty logging in, see your Softconsole 
administrator.
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Logging into IP Configurations

If you are working in an IP configuration, you must log into the server. After you 
successfully start Softconsole, you see the IP Login window.

To log into the server:

1. Start Softconsole according to the procedure in “Starting a Softconsole 
Session,” earlier in this section.

2. At the Login window, enter the following information in the appropriate 
boxes:

■ your assigned extension

■ your password

3. If you want the application to save your password for the next time you log 
into the server, mark the Remember password for next login session 
checkbox.

4. Click Login.

NOTE:
Depending on your configuration, an additional message box may appear 
prompting you to verify the connection by making a test call. Click OK.
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Exiting Softconsole

At the end of your session, exit Softconsole as follows if you are working in a DCP 
configuration. 

NOTE:
If you are working in an IP configuration, after you exit Softconsole 
according to this procedure, go to “Logging Off the Server.”

1. Before you choose to exit your Softconsole session, be sure that no calls 
appear on the console.

2. From the File menu, click Exit.

NOTE:
If the console detects any calls in progress, a warning dialog box is 
displayed. Click Cancel to return to your Softconsole session without 
disconnecting the calls. 

Logging Off the Server

At the end of your session, exit Softconsole as follows if you are working in an IP 
configuration. 

1. Before you choose to exit your Softconsole session, be sure that no calls 
appear on the console.

2. From the File menu, click IP Login.

3. From the IP Login menu, click Logoff Switch.

NOTE:
If the console detects any calls in progress, a warning dialog box is 
displayed. Click Cancel to return to your Softconsole session without 
disconnecting the calls. 
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2
Using the Softconsole Directories

Overview

Softconsole provides a Directory feature to make locating and communicating 
with members of your organization and other business associates convenient. 
Your Softconsole environment can support several directories. During the 
installation and administration of Softconsole, your Softconsole administrator 
creates these directories, which are databases that contain information about 
members of your organization and your business associates. For example, a 
database can contain each person’s first and last names, extension number, and 
other pertinent information. 

Depending on the privileges your Softconsole administrator assigns to you and 
other attendants, Softconsole allows all console attendants to share this 
information. You can use this information to locate individuals—searching for 
them by any field, including first name, last name, phone number, email address 
(if available), and the notes entry. You can also initiate a call or send email to any 
directory entry with just a click. 

The procedures in this chapter allow you to perform several Softconsole directory 
functions, including:

■ Searching for information in a directory. 

■ Placing a call from a directory.

■ Adding, changing, and deleting individual entries that are stored in a 
directory.

■ Making note entries to a directory.

■ Sending email from the directory.

■ Viewing the line status associated with a directory entry.
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Selecting a Softconsole Directory

To access a Softconsole directory, do one of the following:

■ Click the icon associated with the directory.

■ Press ALT-D to access the Directory menu. Then, press the up and down 
arrow keys to move within the Directory names listed in the menu. 
Press ENTER to open the selected directory.

■ Press ALT-D to access the Directory menu. Then, select the directory, and 
press ENTER.

Searching for Information in a 
Softconsole Directory

When the focus is on the directory display area, you can search for a person in a 
Softconsole directory by selecting a search field, and then typing the information 
you want to match.

To search for an entry in a Softconsole directory:

1. In the Sort By box, locate and click on the field name that corresponds to 
the type of search you want to perform. You can select from any field in the 
directory that your administrator has enabled as a search criterion.

2. In the Search box, type the string of text that you want Softconsole to 
locate. Softconsole locates the first record that matches the information 
you have entered thus far.

3. If more than one entry is displayed as a possible match, click on the 
appropriate entry.

The screen displays information from the record you have selected. It may 
include the person’s last name, first name, phone number, and email 
address included in the directory.
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Performing a Typedown Search

Softconsole allows you to perform a “typedown” search, which initiates a search 
as soon as you press any key in the main part of the computer keyboard. The 
search is based on the current sort column. A typedown search enables you to 
start a search with minimal typing. It can also be helpful when you are unsure of 
the exact spelling of the directory record that you seek.

For example, to locate the directory entry for Thomas Addams using the typedown 
search do the following:

1. In the Sort By box, locate and click on the last name field. 

2. In the Search box, type “Ad” and pause. Softconsole returns the first 
record and any additional records that match the keystrokes. If the sort is 
by ascending order, the first matching record appears at the top of the 
directory entry grid. 

For example, Softconsole could return these entries with the first entry 
highlighted:

Andrea Adams
Elizondo Adams
Marcel Adabo
Thomas Addams

3. If you want to refine your search, continue typing. As you enter additional 
keystrokes and pause, Softconsole refines the search and displays the first 
entry that matches all the keystrokes you entered.

NOTE:
If you press a key for which there is no matching record, the selected record 
remains and Softconsole plays a brief error tone.

Making a Call from a Softconsole 
Directory

To make a call from a Softconsole directory:

1. Locate the person you want to call. (See “Searching for Information in a 
Softconsole Directory” in the previous section.)

2. When Softconsole locates the directory entry, press ENTER.

Softconsole dials the extension.
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Maintaining the Information in a 
Softconsole Directory

Refer to the following procedures to maintain the information in a Softconsole 
directory. If you have been assigned permission to do so, you can add, modify, 
view, and delete individual entries in any Softconsole directory. 

Adding an Entry

To add an entry to the Softconsole directory:

1. Do one of the following:

■ Press ALT-D to access the Directory menu, and press A (Add).

■ Click the Add icon on the Directory toolbar.

The Add Directory Entry dialog box is displayed, and the first field is active.

2. Type the information required for this field; then press TAB.

The cursor moves to the next field.

3. Repeat Step 2 until all of the necessary information has been entered for 
this record.

4. To save this new entry, press ENTER.

Modifying an Entry

To modify an entry in the Softconsole directory:

1. Locate the entry you want to edit. (See “Searching for Information in a 
Softconsole Directory” in the previous section.)

2. Do one of the following:

■ Press ALT-D to access the Directory menu, and press E (Edit).

■ Click the Edit icon on the Directory toolbar.

The Modify Directory Entry dialog box is displayed.

3. Edit the appropriate information. You can use the standard Windows 
editing features to add, change, or delete information in any displayed field.

4. To save this modified entry, press ENTER.
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Making Notes About an Entry

To make notes about an entry (if a Notes field is administered) in the Softconsole 
directory:

1. Locate the entry for which you want to make notes. (See “Searching for 
Information in a Softconsole Directory,” in the previous section.)

2. Do one of the following:

■ Press ALT-D to access the Directory menu, and press E (Edit).

■ Click the Edit icon on the Directory toolbar.

The Modify Directory Entry dialog box is displayed.

3. Move to the Notes area using the mouse or TAB key, or by pressing ALT-N 
(Notes). You can use the standard Windows editing features to add, 
change, or delete information in any displayed field.

Enter the note, which may contain information about vacation, travel status, 
or the hours during which the person can be reached. If the administered 
Notes field does not contain a date and time stamp, you may also want to 
include that information. 

4. To save this note, click OK.

The information is saved and will remain with the directory entry until it is 
overwritten or deleted, either by you or by another console attendant.

NOTE:
While active on a call, you can also enter temporary, call-associated 
comments. These are the comments you type directly into the comment 
area of the call appearance. See Chapter 3 for details.

Deleting an Entry

To delete an entry from the Softconsole directory:

1. Locate the entry you want to delete. (See “Searching for Information in a 
Softconsole Directory” in the previous section.)

2. Do one of the following:

■ Press ALT-D to access the Directory menu, and press D (Delete).

■ Click the Delete icon on the Directory toolbar.

A message box asks for confirmation of this deletion.

3. Press ENTER, or click Yes.
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Viewing Information

The directory display area generally presents first name, last name, and phone 
number fields. If you want to see all the information about an entry (including 
email address and any notes), you can open the detailed record associated with 
that entry using the View option. 

Using the Show details option, you can choose to keep a fixed display box open 
so that you can view detailed information at all times. This display box remains 
open and as you advance through directory entries, the detailed information for 
each entry populates the fields in this box.

Viewing the Detailed Record for an Entry

To view all the information related to an entry:

1. Locate the entry for which you want to see complete information. (See 
“Searching for Information in a Softconsole Directory” earlier in this 
chapter.)

2. Do one of the following:

■ Press ALT-D to access the Directory menu, and press V (View).

■ Click the View icon on the Directory toolbar.

A dialog box shows all information, including notes, for the selected entry. 

3. To close the box displaying the current record, press ENTER.

Displaying the Detailed View of Entries

To open a fixed display box showing the detailed record for each entry as it 
becomes highlighted:

1. Do one of the following:

■ Press ALT-D to access the Directory menu, and 
press S (Show details).

■ Click the Show details icon on the Directory toolbar.

A fixed display box opens showing the information defined during 
configuration, including notes, entered in the additional fields. A speed dial 
button appears on the right side of the detail field. This box remains open, 
showing the detailed view of each advancing entry, until you hide it.

2. To hide the detailed view, do one of the following:

■ Press S from the Directory menu.

■ Click the Show details icon on the Directory toolbar.
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Sending email from the Directory

While you are working in the Softconsole directory, you can send an email 
message to anyone. Keep in mind that you can only send email using this 
Softconsole feature; you cannot receive email via the Softconsole.

To send email to an entry in the Softconsole directory:

1. Locate the entry for the person to whom you want to send e-mail. (See 
“Searching for Information in a Softconsole Directory” earlier in this 
chapter.)

2. Verify that the directory entry contains a valid email address.

3. Do one of the following:

■ Press ALT-M. (Note that you do not have to access the Directory 
menu.)

■ Access the Directory menu by pressing ALT-D, and press M 
(Send e-mail).

The standard email message composition window opens. If a valid email 
address is stored for this entry in the Softconsole directory, the application 
automatically addresses the message for you. Otherwise, you must enter 
the appropriate email address.

4. Type the message using the standard procedure.

5. To send this message, click the Send button.

Viewing the Line Status for an Entry

While you are viewing a directory entry associated with an extension, you can 
also view the line status for the associated extension. 

To view the line status for the extension associated with the selected directory 
entry, press ALT-S.

The background color of the directory entry displayed changes to reflect the color 
in the BLF cell corresponding to this extension.
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3
Handling Calls with Softconsole

Overview

The procedural information provided in this chapter describes the activities you 
will perform most frequently with Softconsole. As you become more familiar with 
these activities, you can refer to the Quick Reference booklet as a “memory 
jogger” to help you complete specific tasks.

Call Handling functions are those functions you will perform most frequently in 
Softconsole. In general, these functions include:

■ Answering a call

■ Conferencing multiple parties together on a call

■ Holding a call

■ Placing a call

■ Releasing a call

■ Splitting a call

■ Transferring a call

■ Typing comments about a call

■ Viewing information about second parties and extensions

Before you begin, be sure you understand the components of the call appearance 
and Softconsole window. See Chapter 1 for details.
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Call Handling Methods

You can perform Call Handling functions using any of the following methods:

■ Pressing the appropriate function key (see the table below). 

■ Clicking on the appropriate button on the Action toolbar.

■ Selecting the appropriate option on the Action menu.

■ Pressing the appropriate “hot keys” (keyboard accelerators) that have been 
assigned by your Softconsole administrator. For example, press ALT-D 
simultaneously to access the Directory menu. See the table summarizing 
hot key assignments provided in the Softconsole Release 1.0 Quick 
Reference.

NOTE:
These function keys correspond to the buttons shown on the Action toolbar 
and to the options available on the Action menu in the Softconsole window. 
During certain call-handling operations, additional buttons are enabled. For 
example, after you initiate a conference call, an Add button (F7) is enabled.

* The End Conf button corresponds to the Forced Release button provided by the 
PC Console application. When the Conference feature is enabled, you use the 
End Conf button to remove all participants from the conference call. 

Function Key Action toolbar button/menu option

F3 New

F4 Pickup

F5 Transfer

F6 Conference

F7 Add

F8 Hold

F9 Release

F10 Cancel

F11 End Conf (End Conference)*
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Answering a Call

When an incoming call arrives, your Softconsole will display information about 
that call. The information that you actually see depends upon the configuration of 
your system and Softconsole’s previous call handling status.

NOTE:
Certain conditions require you to use other procedures for answering calls. If 
the Automatic Answer feature is enabled for your call processing system, 
follow the procedure in “Working with the Automatic Answer Feature” at the 
end of this section.

To answer an incoming call:

1. Do one of the following:

— If the red Pickup indicator outlines the call appearance, press F4 
(Pickup).

— Press ALT and the key (1 to 6) corresponding to the appropriate call 
appearance.

— Click on any part of the call appearance except the information 
button or comment area.

2. Assist the caller as necessary.

To answer a second call:

1. Press F8 (Hold) to place the current call on hold.

NOTE:
If your system administrator has enabled the Auto Hold feature of the 
call processing system, you do not need to place an active call on 
hold before picking up or placing another call. Softconsole makes the 
active call on hold automatically when you select any available call 
appearance.

2. Do one of the following:

— If the red Pickup indicator outlines the call appearance, press F4 
(Pickup).

— Press ALT and the key (1 to 6) corresponding to the appropriate call 
appearance.

— Click on any part of the call appearance except the information 
button or comment area.

3. Assist the caller as necessary.
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Answering Emergency Calls

A special type of incoming call is the emergency call. When an emergency call 
arrives, the Softconsole display responds as it does for all incoming calls. In 
addition, the following actions occur:

■ The Emergency feature button (if one is administered) is highlighted.

■ An emergency tone sounds.

■ The background color of the call appearance changes to red.

■ The call appearance identifies the call with the abbreviation EMRG and 
shows the calling party identification.

A typical emergency call has this display format:

The procedure for answering an emergency call is the same as the procedure to 
answer any other call. However, you should respond immediately to an 
emergency call, placing other calls on hold if necessary.

Working with the Automatic Answer Feature

Softconsole produces a ringing sound to alert you when an incoming call arrives. 
Your system administrator, however, can change this standard operation by 
enabling the Automatic Answer feature for your call processing system.

When the Automatic Answer feature is active, you will not hear a ring when a call 
arrives. Instead, Softconsole will establish the connection for you automatically.

a = TOM ROBERTS EXT 3041 in EMRG Q
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Conferencing Multiple Parties
Together on a Call

You can conference up to five participants, plus yourself, on a single call. As you 
add people to the conference call, the call appearance indicates the number of 
participants on the call.

You can initiate a conference call for an incoming or outgoing; however, after the 
Attendant Conference feature is selected, all other calls added to the conference 
must be outgoing.

NOTE:
The Attendant Conference feature is unavailable in the CAS environment.

To set up a conference call:

1. Answer or place the call that is to be conferenced with the other 
participants. 

2. Press F6 (Conference).

An Add button appears on the Action toolbar.

3. Dial the telephone or extension number using the methods described later 
in this chapter.

4. Do one of the following: 

— If the person has answered your call and you are ready to add this 
person to the conference, press F7 (Add).

— If the person does not answer your call or does not wish to join the 
conference call, press F10 (Cancel).

5. If you want to add another person to the call, repeat this procedure from 
Step 3.

Removing Yourself from a Conference Call

You can remove yourself from a conference call without affecting the other 
participants on the conference call. 

To remove yourself from a conference call, press F9 (Release) on the call 
appearance associated with the conference call.

The call is removed from your display, but continues undisturbed for the remaining 
participants.
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Ending a Conference Call

When you end a conference call, the call is ended for all participants connected to 
the conference call.

NOTE:
PC Console attendants should note that the End Conf (End Conference) 
button used in the following procedure corresponds to the Forced Release 
button on the PC Console.

To end a conference call:

1. On the call appearance associated with the conference call, press F11 
(End Conf).

The confirmation dialog box appears.

2. Press ENTER to confirm that you want to end the conference.

The call is removed from your display and ended for all people who were 
participating in the conference call.
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Holding a Call

You can put any call (including single-party and conference calls) on hold at the 
Softconsole workstation. It is possible to have a held call on each of the six call 
appearances. 

NOTE:
If you are working in a CAS environment, you must place a CAS call on 
Remote Hold. Follow the procedures in “Using Remote Hold in a CAS 
Environment” at the end of this section.

The Attendant Lockout feature can be used to prevent you from directly 
re-entering a conference call (or other multiparty call) that is being held. When the 
Attendant Lockout feature is enabled, one of the participants must call you for 
assistance via the Attendant Recall feature.

! CAUTION:
If a single-party call is held for longer than the timed reminder interval 
programmed in the call processing system, its call appearance will turn red, 
and a timed reminder tone will sound. Retrieve the call in the usual way, but 
you must handle this call before accepting any new calls.

Holding the Current Call

To hold the current call, press F8 (Hold) on the call appearance. You can now use 
the up and down arrow keys to retrieve the next held call (if any).

Making Comments about a Held Call

You can make and edit comments about a held call using the comment area of the 
associated call appearance. 

Click on the comment area of the call appearance to enter a comment or edit an 
existing comment. To exit the comment area, press TAB to access another call 
appearance or click outside the comments area on the call appearance.

NOTE:
When you click on the comment area of the call appearance 
associated with the held call, you do not retrieve the held call. 
Similarly, you do not lose an active call associated with another call 
appearance when you click on the comment area of the call 
appearance associated with the held call.
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Retrieving a Held Call

To retrieve (pick up) a held call, do one of the following:

■ Press F4 (Pickup) on the call appearance.

■ Press ALT and the key (1 to 6) corresponding to the appropriate 
call appearance.

■ Click anywhere on the call appearance except the information button or 
comment area.

Working with the Auto Hold Feature

If your system administrator has enabled the Auto Hold feature of the call 
processing system, you do not need to place an active call on hold before picking 
up or placing another call. 

To place a call on hold when the Auto Hold feature is enabled:

1. While active on a call, explain that you are placing the call on hold.

2. Select an available call appearance in one of the following ways:

— Press F4 (Pickup).

— Press ALT and the key (1 to 6) corresponding to the appropriate call 
appearance.

— Click on any part of the call appearance except the information 
button or comment area.

3. Answer or place a call using the methods described in this chapter. 

Using Remote Hold in a CAS Environment

When a CAS caller wants to wait, put the call on Remote Hold (not Hold) to free 
the console and RLT for other calls.

To put the current CAS call on Remote Hold at the originating branch location:

1. Press F5 (Transfer) on the associated call appearance.

2. Dial the Remote Hold feature access code as administered at the 
originating branch location.

3. When you hear the Remote Hold confirmation tone, press F9 (Release).

The call is released from the console.
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To answer a returning call that was previously put on Remote Hold:

1. Press F4 (Pickup) on the associated call appearance.

2. Report to the caller.

— If the calling party wants to continue to hold, reactivate Remote Hold 
by entering the Remote Hold feature access code.

— If the calling party wants to be connected to another extension, go to 
Step 3.

3. Press F10 (Cancel). 

You can now transfer the call to another extension.
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Making a Call

You can make calls to extension numbers inside your system, as well as calls to 
external telephone numbers through trunks. These procedures are outlined 
below.

Making a Call to an Extension Number

NOTE:
If the system administrator has enabled the Auto Start feature on your call 
processing system, you do not need to press F3 or to select an available call 
appearance before entering the extension number.

To call an extension number:

1. Do one of the following:

— Press F3 (New). 

— Press ALT and the key (1 to 6) corresponding to an available call 
appearance.

— Click anywhere on the call appearance except the information 
button or comment area.

NOTE:
You can use the Softconsole Directory feature to locate and dial an 
extension number. See Chapter 2 for instructions.

2. Dial the extension number using the dialpad on your computer keyboard. 

You can enter any of the following: numbers 0 through 9, comma, 
asterisk (*), and pound (#).

3. Listen for the call progress tones.

— If you hear ringback tone, the called extension is idle and ringing. 
When the call is answered, you can begin speaking.

— If you hear busy tone, the extension is busy. Press F9 (Release); 
then try again later.

— If you hear Call Waiting ringback tone, the extension is busy and the 
call is Call Waiting. Either wait to talk to the called party, or press F9 
(Release); then try again later.

— If you hear intercept tone, you entered an invalid extension. 
Press F10 (Cancel).
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Making a Call to an Extension Number Using 
Direct Extension Select (DXS)

You can make calls using the Direct Extension Select/Busy Lamp Field 
(DXS/BLF) feature only when the following conditions exist:

■ The necessary Hundreds Group tab is displayed (or the Group Select 
feature is available).

■ Sufficient area is available in the Softconsole window to display the 
DXS/BLF, and you have not chosen to hide the DXS/BLF.

To call an extension number using the Direct Extension Select/Busy Lamp Field 
(DXS/BLF) feature:

1. Do one of the following:

— If the extension is displayed in the DXS/BLF, click on the DXS/BLF 
cell associated with the extension.

— If the extension is not displayed in the DXS/BLF, click on the 
appropriate Hundreds Group tab. Then, click on the DXS/BLF cell 
associated with the extension.

NOTE:
If the appropriate Hundreds Group is not currently administered on a 
DXS/BLF tab, you can use the Group Select feature button (if 
available) and enter the Hundreds Group number on your keyboard.

2. Listen for the call progress tones.

— If you hear ringback tone, the called extension is idle and ringing. 
When the call is answered, you can begin speaking.

— If you hear busy tone, the extension is busy. Press F9 (Release); 
then try again later.

— If you hear Call Waiting ringback tone, the extension is busy and the 
call is Call Waiting. Either wait to talk to the called party, or press F9 
(Release); then try again later.

— If you hear intercept tone, you entered an invalid extension. 
Press F10 (Cancel).
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Making a Call to an External Telephone Number

An external call requires that you access an outgoing trunk, then dial the number. 
You can access the trunk by dialing an access code for that trunk group—such as 
a Private Network, Automatic Alternate Routing (AAR), or Automatic Route 
Selection (ARS)—or by clicking the appropriate Trunk Group Select button.

To make a call to an external telephone number:

1. Do one of the following:

— Press F3 (New). 

— Press ALT and the key (1 to 6) corresponding to an available call 
appearance.

NOTE:
If the Auto Start feature is enabled on your call processing system, 
you can begin entering the trunk access code immediately. You do 
not need to press F3 or to select an available call appearance.

2. Enter the trunk access code using your computer keyboard. 

3. Listen for the appropriate dial tone.

4. Enter the external telephone number using the numeric keypad on your 
computer keyboard. 

You can enter numbers 0 through 9, comma, asterisk (*), and 
pound (#).

— When the call is answered, you can begin speaking.

— If you hear busy tone or the call is not answered, 
press F9 (Release). Then, try again later.

Making a Call to an External Telephone Number 
Using the Trunk Group Select Button

To make a call to an external number using the Trunk Group Select button (or by 
selecting the trunk group from the Trunk Menu):

1. Click on the appropriate Trunk Group Select button.

2. Listen for the appropriate dial tone.
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3. Enter the external telephone number using the dialpad on your computer 
keyboard.

You can enter numbers 0 through 9, comma, asterisk (*), and 
pound (#).

— When the call is answered, you can begin speaking.

— If you hear busy tone or the call is not answered, 
press F9 (Release). Then, try again later.

Making a Second Call without Auto Hold

To make a second call when Auto Hold is not administered on your call processing 
system:

1. While active on a call, explain that you are placing the call on hold.

2. Press F8 (Hold) on the associated call appearance.

3. Use the up and down arrow keys to select an available call appearance.

4. Dial the extension or external telephone number using the methods 
described earlier in this chapter.

— When the call is answered, you can begin speaking.

— If you hear busy tone or the call is not answered, 
press F9 (Release). Then, try again later.

Making a Second Call with Auto Hold

To make a second call when Auto Hold is administered on your call processing 
system:

1. While active on a call, explain that you are placing the call on hold.

2. Select an available call appearance in one of the following ways:

— Press F4 (Pickup).

— Press ALT and the key (1 to 6) corresponding to the appropriate call 
appearance.

— Click on any part of the call appearance except the information 
button or comment area.

3. Dial the extension or external telephone number using the methods 
described in this chapter.

— When the call is answered, you can begin speaking.

— If you hear busy tone or the call is not answered, 
press F9 (Release). Then, try again later.
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Releasing a Call

Releasing a call is sometimes referred to as “hanging up.” You can release one 
call at a time.

To release a call, press F9 (Release) on the associated call appearance.

Splitting a Call

The Attendant Auto-Manual Splitting feature lets you temporarily disconnect from 
a caller, place a call to another party, and then connect the two parties together. 

NOTE:
The Attendant Auto-Manual Splitting feature is not available in the CAS 
environment. Follow the procedures in “Transferring Calls in a CAS 
Environment,” later in this manual.

When the Split feature button is administered, you use this feature to transfer an 
incoming call to an outside number. Splitting allows you to take the following 
steps:

■ Either talk to the second party to announce the waiting call or drop off the 
call before the second party answers.

■ Connect the first and second parties together.

■ Join the first and second parties in a three-way connection from which you 
can later drop out.

■ Return to the first party if the second party does not answer or declines to 
join the call.

This feature is activated automatically when answer an incoming call and do one 
of the following:

■ Click the Transfer icon or press F5 (Transfer) to transfer the call.

■ Click a Hundreds Group button and Busy Lamp Field.

■ Click a Trunk Group button.

■ Dial a number using the dial capabilities of the Softconsole Directory 
feature.

While the caller is split from the console, the Split feature button is displayed in 
green.
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The split condition is canceled, and the Split feature button is displayed in gray 
when you do one of the following:

■ Press F9 (Release) to finish connecting the first party to the second party 
and to disconnect the console.

■ Click the Split feature button to establish a three-way connection with you, 
the first party, and the second party. If the second party has dropped off the 
call, Softconsole automatically cancels the split and returns you to the 
other caller.

■ Click the Cancel button or press F10 (Cancel) to cancel the outgoing call 
attempt and reconnect you to the first party.

■ Click the Forced Release feature button on the associated call 
appearance to end the call for all connected parties.

Transferring a Call

You can transfer calls to an inside extension or to an outside telephone number 
through a trunk. 

Two types of call transfers are possible: Supervised Transfers (that is, transferred 
calls that you announce) and Unsupervised Transfers (that is, transferred calls 
that you do not announce). 

Auto Transfers, which are a specific type of unsupervised transfer, can only be 
used to transfer an incoming call to an extension in your organization. Your 
system administrator determines whether the Auto Transfer feature is enabled as 
the standard transfer mode for your system. 

NOTE:
If the Softconsole administrator has programmed your Softconsole to 
perform Auto Transfers, while active on a call you can temporarily disable 
the Auto Transfer feature and announce the call. See “Temporarily Disabling 
the Auto Transfer Feature.”

Supervised transfers allow you to announce the call that you are transferring. 
Transferring a call in the supervised mode consists of answering an incoming call, 
splitting, placing another call, and then connecting the two calls together.

NOTE:
If you are working in a CAS environment, follow the procedures in 
“Transferring Calls in a CAS Environment” at the end of this section.
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You will transfer calls when one of the following occurs:

■ A caller asks to be connected to an extension within the system. The 
incoming call will usually be a trunk call from outside the system, but it can 
also be from an inside extension.

■ An inside extension caller in your own system asks to be connected to an 
external number through a trunk.

■ A person on an incoming trunk call asks to be connected to an external 
number on another trunk.

Temporarily Disabling the Auto Transfer Feature

By disabling the Auto Transfer feature, you can announce a call before you 
transfer the call to an extension. While active on a call, you can disable the Auto 
Transfer feature temporarily in one of the following ways:

■ If you are using the numeric keypad on your computer to enter the 
extension number, press and hold down the SHIFT key while you enter the 
key sequence representing the extension number.

■ If you are using the DXS/BLF to select the extension number, 
press and hold down the SHIFT key while you click on the DXS/BLF cell 
corresponding to the extension number.

■ If you are using the search and dial capability of the Softconsole Directory 
feature to select the extension number, press SHIFT-ENTER.

Transferring a Call to an Extension
Using Auto Transfer (Unsupervised)

Verify that the Auto Transfer feature is enabled for your system.

To place the incoming call on hold automatically and transfer the call to an inside 
extension:

1. Answer the incoming call using the methods described earlier in this 
chapter.

2. Press F5 (Transfer).

3. Dial the extension number using the dialpad of your computer keyboard, 
the DXS/BLF feature, or the search and dial capability of the Softconsole 
Directory feature.
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Transferring a Call to an Extension (Supervised)

To announce an incoming call before transferring it to an inside extension:

1. Answer the incoming call using the methods described earlier in this 
chapter.

2. Press F5 (Transfer).

NOTE:
If the Auto Start feature is enabled for your call processing system, 
you can begin dialing the extension number immediately. You do not 
need to press F5 (Transfer).

3. Dial the extension number using the methods described earlier in this 
chapter.

NOTE:
If Auto Transfer is enabled, override that feature now according to the 
instructions in “Temporarily Disabling the Auto Transfer Feature.” 

4. When the called party answers, announce the call, and do one of the 
following:

— If the called party accepts the call, press F9 (Release) to complete 
the transfer. 

— If the called party declines the call, press F10 (Cancel) to reconnect 
to the caller. Tell the caller that the called party is unavailable, and 
take a message, if appropriate. Then, press F9 (Release) to 
disconnect the call. 

NOTE:
If the line is busy or there is no answer, press F10 (Cancel). The call 
progress tones stop, and you are reconnected to the caller. Tell the 
caller that the called party is unavailable, and take a message, if 
appropriate. Then, press F9 (Release) to disconnect the call. 

Transferring a Call to an Extension 
Using the DXS/BLF Feature

You can transfer calls using the Direct Extension Select/Busy Lamp Field 
(DXS/BLF) feature only when the following conditions exist:

■ The necessary Hundreds Group tab is displayed (or the Group Select 
feature is available).

■ Sufficient area is available in the Softconsole window to display the 
DXS/BLF, and you have not chosen to hide the DXS/BLF.
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To transfer a call from one extension to another using the DXS/BLF feature:

1. Answer the incoming call using the methods described earlier in this 
chapter.

2. Tell the caller that you are going to break the connection temporarily while 
you start the outbound call.

3. Do one of the following:

— If the extension is displayed in the DXS/BLF, click on the DXS/BLF 
cell associated with the extension.

— If you want to override the Auto Transfer feature, press SHIFT while 
you click on the DXS/BLF cell associated with the extension.

— If the extension is not displayed in the DXS/BLF, click on the 
appropriate Hundreds Group tab. Then, click on the DXS/BLF cell 
associated with the extension.

NOTE:
If the appropriate Hundreds Group is not currently administered on a 
DXS/BLF tab, you can use the Group Select feature button (if 
available) and enter the Hundreds Group number on your keyboard.

If the Auto Transfer feature is enabled, the transfer is complete. Otherwise, 
go to Step 4.

4. When the called party answers, announce the call and do one of the 
following:

— If the called party accepts the call, press F9 (Release) to complete 
the transfer. 

— If the called party declines the call, press F10 (Cancel) to reconnect 
to the caller. Tell the caller that the called party is unavailable, and 
take a message, if appropriate. Then, press F9 (Release) to 
disconnect the call. 

NOTE:
If the line is busy or there is no answer, press F10 (Cancel). The call 
progress tones stop, and you are reconnected to the caller. Tell the 
caller that the called party is unavailable, and take a message, if 
appropriate. Then, press F9 (Release) to disconnect the call. 
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Transferring a Call from an Extension to an 
External Telephone Number

To transfer a call from an inside extension to an external telephone number:

1. Answer the incoming call using the methods described earlier in this 
chapter.

2. Before attempting the transfer, verify that the outgoing call is allowed in 
your environment.

3. Tell the caller that you are going to break the connection temporarily while 
you start the outbound call.

4. Press F5 (Transfer).

NOTE:
If the Auto Start feature is enabled for your call processing system, 
you can begin entering the trunk access code immediately. You do 
not need to press F5 (Transfer).

5. Dial the access code for the appropriate trunk.

6. When the called party answers, announce the call and do one of the 
following:

— If the called party accepts the call, press F9 (Release) to complete 
the transfer. 

— If the called party declines the call, press F10 (Cancel) to reconnect 
to the caller. Tell the caller that the called party is unavailable, and 
take a message, if appropriate. Then, 
press F9 (Release) to disconnect the call. 

NOTE:
If the line is busy or there is no answer, press F10 (Cancel). The call 
progress tones stop, and you are reconnected to the caller. Tell the 
caller that the called party is unavailable, and take a message, if 
appropriate. Then, press F9 (Release) to disconnect the call. 
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Transferring an Inside Call 
Using the Trunk Group Select Button

To transfer a call from an inside extension to an external telephone number using 
the Trunk Group Select button:

1. Answer the incoming call using the methods described earlier in this 
chapter.

2. Before attempting the transfer, verify that the outgoing call is allowed in 
your environment.

3. Tell the caller that you are going to break the connection temporarily while 
you start the outbound call.

4. Press F5 (Transfer).

5. Click on the appropriate Trunk Group Direct Select button (or select the 
appropriate trunk group from the Trunk menu).

6. Dial the external telephone number using the methods described earlier in 
this chapter.

7. When the called party answers, announce the call and do one of the 
following:

— If the called party accepts the call, press F9 (Release) to complete 
the transfer. 

— If the called party declines the call, press F10 (Cancel) to reconnect 
to the caller. Tell the caller that the called party is unavailable, and 
take a message, if appropriate. Then, 
press F9 (Release) to disconnect the call. 

NOTE:
If the line is busy or there is no answer, press F10 (Cancel). The call 
progress tones stop, and you are reconnected to the caller. Tell the 
caller that the called party is unavailable, and take a message, if 
appropriate. Then, press F9 (Release) to disconnect the call. 
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Transferring an Incoming Trunk Call to an 
External Telephone Number (Unsupervised)

NOTE:
You can perform this procedure only if Trunk-to-Trunk Transfer is enabled on 
your call processing system. For additional information, refer to 
“Trunk-to-Trunk Transfer” in the Softconsole Release 1.0 Attendant System 
Features manual.

To transfer an incoming trunk call to an external number without announcing the 
call:

1. Answer the incoming call using the methods described earlier in this 
chapter.

2. Tell the caller that you are going to break the connection temporarily while 
you start the outbound call.

3. Dial the access code for the appropriate trunk.

NOTE:
If you hear reorder tone, the trunk is not available. Click the Split 
feature button to reconnect to the caller and ask the caller to try again 
later. 

4. Dial the external telephone number using the methods described earlier in 
this chapter. You can enter numbers 0 through 9, comma, asterisk (*), and 
pound (#).

5. To set up a three-way connection that includes the console, click the Split 
feature button before the called party answers. 

6. Press F9 (Release) before the called party answers.

Transferring an Incoming Trunk Call to an 
External Telephone Number (Supervised)

NOTE:
You can perform this procedure only if the Trunk-to-Trunk Transfer feature is 
enabled on your call processing system. For additional information, refer to 
“Trunk-to-Trunk Transfer” in the Avaya Softconsole  Release1.0 Attendant 
System Features Guide.

To transfer an incoming trunk call to an external telephone number:

1. Answer the incoming call using the methods described earlier in this 
chapter.

2. Tell the caller that you are going to break the connection temporarily while 
you start the outbound call.
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3. Dial the access code for the appropriate trunk.

NOTE:
If you hear reorder tone, the trunk is not available. Click the Split 
feature button to reconnect to the caller and ask the caller to try again 
later. 

4. Dial the external telephone number using the methods described earlier in 
this chapter. You can enter numbers 0 through 9, comma, asterisk (*), and 
pound (#).

5. To set up a three-way connection that includes the console, click the Split 
feature button before or after the called party has answers. 

NOTE:
If you want to drop off the three-way connection, press 
F9 (Release). 

6. To announce the call before transferring it, wait until the called party 
answers and notify the called party of the incoming call.

7. Do one of the following:

— If the called party accepts the call, press F9 (Release) to complete 
the transfer. 

— If the called party declines the call, press F10 (Cancel) to reconnect 
to the caller. Tell the caller that the called party is unavailable, and 
take a message, if appropriate. Then, 
press F9 (Release). 

— If the line is busy or there is no answer, press F10 (Cancel). 
You are reconnected to the caller. Tell the caller that the called party 
is unavailable, and take a message, if appropriate. Then, 
press F9 (Release). 
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Transferring Calls in a CAS Environment

You can transfer CAS calls to an extension or external telephone number at the 
branch using the procedures provided in this section. As you perform these 
procedures, keep in mind that you can use several additional features. For 
example, to speed the dialing procedure when transferring a CAS call, you can 
use the following features:

■ Abbreviated Dialing

■ Attendant Direct Trunk Group Selection

■ Directory

■ Hundreds Group button and associated Busy Lamp Fields

NOTE:
The Busy Lamp Fields do not indicate busy extension numbers at the 
branch locations.

■ Facility Busy Indication

While transferring a CAS call, you may also use branch features, such as Code 
Calling Access and Loudspeaker Paging Access.

Transferring CAS Calls to the Originating Branch

To transfer a CAS call to the originating branch:

1. Answer the incoming call using the methods described earlier in this 
chapter.

2. Press F5 (Transfer), and listen for dial tone from the branch location.

! CAUTION:
Do not go to the next step until you hear dial tone. The call will not go 
through if you dial the number before you hear dial tone.

3. Dial the extension using the numeric keypad of your computer keyboard, 
the DXS/BLF feature, or the search and dial capability of the Softconsole 
Directory feature.

NOTE:
If the Auto Transfer feature is enabled, the call is transferred 
automatically. 
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4. When the called party answers, announce the call, and do one of the 
following:

— If the called party accepts the call, press F9 (Release) to complete 
the transfer. 

— If the called party declines the call, press F10 (Cancel) to reconnect 
to the caller. Tell the caller that the called party is unavailable, and 
take a message, if appropriate. Then, 
press F9 (Release) to disconnect the call. 

NOTE:
If the line is busy or there is no answer, press F10 (Cancel). The call 
progress tones stop, and you are reconnected to the caller. Tell the 
caller that the called party is unavailable, and take a message, if 
appropriate. Then, press F9 (Release) to disconnect the call. 

Transferring CAS Calls to Other Branches

To transfer a CAS call to a branch other than the originating branch:

1. Answer the incoming call using the methods described earlier in this 
chapter.

2. Press F5 (Transfer), and listen for dial tone from the branch location.

! CAUTION:
Do not go to the next step until you hear dial tone. The call will not go 
through if you dial the number before you hear dial tone.

3. If your company locations do not have a universal dial plan (UDP), dial the 
trunk access code for the requested branch location (as administered at 
the originating branch). 

4. Dial the extension number at the branch. Using the numeric keypad on 
your computer keyboard, the DXS/BLF feature, or the search and dial 
capability of the Softconsole Directory feature.

NOTE:
If the Auto Transfer feature button is enabled, the call is transferred 
automatically. 
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5. When the called party answers, announce the call, and do one of the 
following:

— If the called party accepts the call, press F9 (Release) to complete 
the transfer. 

— If the called party declines the call, press F10 (Cancel) to reconnect 
to the caller. Tell the caller that the called party is unavailable, and 
take a message, if appropriate. Then, 
press F9 (Release) to disconnect the call. 

NOTE:
If the line is busy or there is no answer, press F10 (Cancel). The call 
progress tones stop, and you are reconnected to the caller. Tell the caller 
that the called party is unavailable, and take a message, if appropriate. 
Then, press F9 (Release) to disconnect the call. 

Answering a Returning Call in a CAS 
Environment

To answer a returning call that was previously transferred:

1. Press F4 (Pickup) on the associated call appearance.

2. Report to the caller.

— If the calling party still wants to wait. Go to Step 3.

— If the calling party wants to be connected to another extension, go to 
Step 4.

3. Press F9 (Release).

The call is transferred again. (Dialing is unnecessary.)

NOTE:
You must redial if the previously transferred call was directed to a 
single-line telephone.

4. Press F10 (Cancel).

You can now transfer the call to another extension.
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Typing Comments About a Call

While active on call, you can enter temporary, call-associated comments in the 
comment area of the call appearance. You will find this feature helpful when you 
need to move to a different call, but do not want to forget some detail about the 
current call.

To type a temporary comment:

1. Click in the comment area of the call appearance associated with the call. 

NOTE:
Instead of using the mouse, you can press TAB until the comment 
area you want has the focus.

2. Use the keyboard to type comments. While you are working in the 
comment area, you can:

— Use all the main keyboard keys, arrow keys, and page control keys 
(such as Page Up, Page Down, Home, etc.) to navigate the 
comment area.

— Edit the content of the comment.

The comment will remain on the call appearance until you overwrite it, 
delete it, or release the call.

3. To leave the comment area, do any of the following:

— Click outside the comment on the call appearance.

— Press TAB to access another call appearance.

— Select another Softconsole function (such as using a call handling 
function key or button, clicking on a feature button, selecting a new 
directory, etc.)
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Viewing Additional Second Party 
Information

The More Information button (labeled “i”) is displayed to the right of the Second 
Party Name area on the call appearance. You can click on this button to access a 
read-only dialog box containing all the information available in Softconsole for this 
person.

To view the information for the selected party:

1. Do one of the following:

— Press ALT-I.

— Click on the More Information button.

A dialog box opens displaying all the information available in Softconsole 
for this person.

2. To close the dialog box, press ENTER or click OK.

Viewing Information from the 
DXS/BLF

While you are handling calls from the DXS/BLF, you can quickly access the 
directory record, including the name and any notes, for an extension.

To view the directory record for a particular extension:

1. Right-click on the DXS/BLF cell corresponding to the extension.

A dialog box opens displaying the associated directory name and notes.

2. To close the dialog box, press ENTER or click OK.
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4
Troubleshooting

Overview

This chapter provides procedures and recommendations that will assist you in 
resolving problems. Some of the procedures in this chapter are intended for 
configurations that use Internet Protocol (IP) connectivity. Other procedures are 
specific to configurations using Digital Communications Protocol (DCP) 
connectivity. Check with your Softconsole administrator regarding the connectivity 
used in your environment.

Refer to the appropriate section in this chapter, according to the type of problem 
you are attempting to identify and correct.

This chapter includes the following information in the order listed below:

■ Troubleshooting IP installation-specific problems

■ Troubleshooting problems with the telephone (DCP installations)

■ Troubleshooting Softconsole operation problems

■ Troubleshooting call processing system problems

NOTE:
If you cannot resolve problems using the procedures provided in this 
chapter, consult your Softconsole administrator.
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Troubleshooting IP 
Configuration-specific Problems

If you encounter difficulties related to Softconsole operation specific to IP 
connectivity, refer to the troubleshooting information provided by the integrated 
Avaya iClarity IP Audio online help.

Potential problems include:

■ The caller or called party cannot hear the attendant.

■ The attendant cannot hear the caller or called party.

■ The attendant cannot hear the caller or called party clearly.

■ The caller or called party indicates that your words are not being 
transmitted clearly (that is, the beginning or ending sounds of words are not 
transmitted).

Troubleshooting Problems with the 
Telephone

If you encounter difficulties related to the telephone connected to the Softconsole 
computer (in DCP configurations only), consult the following table to isolate and 
resolve the problem.

Symptom Recommended Solution

The Position Busy Lamp is not lit, and the 
Position Available indicator is not 
updated when you first log in.

This is not a problem. Click the Position 
Busy button. Then, click on the button 
again to reset the indicators.

You cannot use the telephone (for 
example, an 8411 telephone or 
CallMaster VI telephone) in the usual 
manner.

This is not a problem. The Softconsole 
environment disables the standard 
functionality of the telephone.

You can hear the incoming caller through 
the speaker, but the caller cannot hear 
you.

Use the handset on the telephone, 
instead of using the speaker.
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Troubleshooting Softconsole 
Operation Problems

Symptom Recommended Solution

Double-clicking on 
the Softconsole 
icon has no effect.

Do one of the following:

■ Hold down ALT and press TAB until you 
locate the Softconsole application. Then, 
release ALT.

■ Hold down CTRL and press ESC to open a 
Task List on the screen. Highlight 
Softconsole on this list, and click Switch To.

Softconsole is 
slow in 
responding to 
your commands.

1. Exit Softconsole. 

2. Close all other applications, and exit 
Windows to free up all memory resources.

3. Restart Windows, restart Softconsole, and 
run only those applications that are 
necessary.

Softconsole does 
not respond to 
any call 
processing 
system-related 
activity. For 
example, call 
handling and 
feature buttons 
are not 
functioning.

Verify that the application is communicating with 
the PassageWay Adapter, 8411 telephone, or 
CallMaster VI telephone. 

■ If you are using a PassageWay Adapter, 
its green LED should be steadily lighted. 

■ If you are using an 8411 telephone, 
button 10 on the telephone should be 
steadily lighted. 

■ If this is not the case, refer to the 
product’s troubleshooting 
documentation.

Softconsole 
consistently 
ignores incoming 
calls.

1. Verify that Softconsole is in the appropriate 
Day or Night setting for your environment.

2. Verify that the Position Busy feature is not 
activated.

Softconsole 
cannot make 
outgoing calls 
(except through 
the Integrated 
Directory, if 
administered). 

1. Restart the computer. 

2. While the computer is restarting, disconnect 
and immediately reconnect either end of the 
cable between the computer and the 
PassageWay Adapter, 8411 telephone, or 
CallMaster VI telephone. This reconnection 
will force the two components to 
resynchronize their signals.
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When you initiate 
calls to external 
telephone 
numbers using 
the Directory 
feature, the calls 
cannot be 
processed.

Verify that the correct area codes for these 
external telephone numbers are shown in the 
directory entries. If area codes need to be 
updated, contact your Softconsole 
administrator.

Verify that Softconsole is configured to include 
any access code required to place 
long-distance or local calls. For example, your 
call processing system may require you to dial 
“9” to access an outside line and make a local 
call.

1. Access the View menu, and select TAPI 
Configuration.

2. In the Phone and Modem Options window, 
click on the Dialing Rules tab.

3. Click Edit to display the Edit Location 
window.

4. In the Dialing Rules area, enter the required 
access code in the appropriate box.

5. Click OK to close the dialog box.

6. Click OK to save the new information.

When you initiate 
a call and hear 
dial tone, the 
numeric keypad 
on your computer 
keyboard does 
not respond to 
your entries.

Press the NumLock key to enable it.

When you initiate 
a transfer and 
hear dial tone, the 
numeric keypad 
on your computer 
keyboard does 
not respond to 
your entries.

Press the NumLock key to enable it.

Symptom Recommended Solution
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Troubleshooting Call Processing 
System Problems

Alarms that are generated by the call processing system produce visible signals at 
the console, at selected telephones, and at the system equipment cabinet. If the 
call processing system has a link to a remote maintenance site, your system 
alarms will be sent to the remote site automatically.

Otherwise, you are responsible for reporting system-generated alarms to the 
system manager immediately.

Console Alarm Indicators

Your console has built-in alarm lamps that indicate major and minor troubles on 
the call processing system. The feature buttons on the console can also be 
administered as alarm indicators to identify more specific problem conditions.

Alarm and Alarm Reported Indicators

Two alarm indicators appear in the Status bar of the Softconsole window. They 
are labeled Alarm and Alarm Reported. The alarm indicators are displayed only 
when a call-processing system problem is detected and are automatically 
removed when the trouble is cleared.

If your call processing system includes the remote maintenance option, the Alarm 
Reported indicator is displayed to indicate that the system has alerted the 
maintenance organization. After the maintenance organization has been notified, 
the maintenance organization assumes responsibility for clearing the problem.

If the Alarm Reported indicator is displayed for any extended length of time after 
the Alarm indicator appears, this means that the system is unable to notify the 
maintenance organization. The attendant must notify the system manager of this 
unresolved alarm condition.

If your call processing system does not have the remote maintenance option, the 
Alarm Reported indicator will not appear on the console display in the event of an 
alarm condition. In this case, you must notify the system manager that the alarm 
condition exists.
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Optional Alarm Lamps

The Alarm indicator does not distinguish between major and minor alarms. If this 
information is pertinent, a Major Alarm feature button should be administered on 
the console. This feature button will be displayed in white when a major alarm 
problem exists.

If the Alarm indicator is displayed and the Major Alarm feature button is displayed 
in green, this indicates a major alarm. If only the Alarm indicator is displayed, this 
indicates a minor alarm.

Other feature buttons can be administered as trouble indicators for links between 
the call processing system and peripheral support equipment or to indicate 
problem at other sites. A Link Failure feature button is displayed in white to 
indicate major, minor, and warning alarms. (In systems with the Hospitality 
Services package, a PMS Link Failure feature button is displayed in white to 
indicate trouble in the link between the call processing system and the 
customer-supplied Property Management System.)

You can cause the white Major Alarm feature button to go gray by clicking that 
button. If the trouble is cleared before system maintenance detects it again, the 
feature button remains gray.

Feature buttons administered for the Facility Busy Indication feature remain white 
as long as the links are active, but go gray if a link fails.

The call processing system does not report link failures to the remote 
maintenance organization. The attendant must notify the system manager 
immediately of any indication of link trouble.

Four feature buttons can be administered to function as hardware alarm indicators 
for users associated with call-processing system maintenance or for users who 
monitor system performance: 

■ A PMS Printer Alarm feature button is displayed in green when the PMS 
printer interface has a problem.

■ An Auto Wakeup Alarm feature button is displayed in green when the 
interface to the PMS Auto Wakeup printer has a problem. 

■ A CDR 1 Failure-In feature button is displayed in green when its interfaces 
to the primary SMDR output devices have a problem.

■ A CDR 2 Failure-In feature button is displayed in green when its interfaces 
to the secondary SMDR output devices have a problem.
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Call Processing System Troubleshooting Features 

You can use the following features to perform simple trouble isolation and analysis 
of problems:

■ Automatic Circuit Assurance — Used for monitoring possible trunk 
failures.

■ Busy Verification of Telephones and Trunks — Used for placing test 
calls.

■ DCS Busy Verification of Telephones and Remote Trunks — Used for 
placing test calls to remote telephones and trunks on the DCS link.

■ Trunk Group Busy/Warning Indicators to Attendant — Used to provide 
an indication of trunk usage.

■ Trunk Identification — Used to specifically identify the trunk where a 
problem is occurring.
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Automatic Circuit Assurance (ACA)

This feature helps you identify trunks that may be faulty. The call processing 
system maintains a record of individual trunk activity, relative to short- and 
long-long time calls. The system automatically initiates a referral call when it 
detects a possible failure. The attendant group or an individual attendant can be 
assigned as the referral call destination.

A referral call will arrive on an available call appearance. When you select that call 
appearance, its display will identify the call as an ACA call, identify the trunk group 
access code and trunk group member number, and show the reason for referral 
— either a short- or long-holding time. This information remains on the call 
appearance until you release the call. You can then use the Busy Verification of 
Telephones and Trunks feature to check the trunk.

The ACA feature provides better service through early detection of faulty trunks, 
and consequently, reduces out-of-service time. Some types of trunk failure cause 
people to shorten their calls. For example, an excessive number of short calls 
may indicate a noisy trunk. Similarly, a trunk that remains busy for an abnormally 
long time may be permanently busy due to a trunk fault. The ACA feature takes 
advantage of these characteristics to identify those trunks that may be defective.

The ACA must be enabled by the system manager. After this feature is enabled, a 
single attendant console (per call processing system) can be assigned an ACA 
feature button to activate and deactivate the ACA referrals. ACA should remain 
activated at all times, if it is enabled at your system.

To activate ACA referrals:

Click the ACA feature button.

The ACA feature button is displayed in white, and ACA is activated.

To deactivate ACA referrals:

Click the ACA feature button.

The ACA feature button is displayed in gray, and ACA is deactivated.

Busy Verification of Telephones and Trunks

This feature allows you to place test calls to trunks, telephones, and hunt groups 
(DDC and UCD groups). Busy Verification provides an easy method of checking 
the condition of these facilities. When the feature is activated, you can distinguish 
between a telephone or trunk that is truly busy and one that only appears busy 
because of some trouble condition or because it was administered without 
hardware.

The result of a busy verification test may be a display, a tone, or a conversation 
with the called facility.
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In the following procedures, a successful verification indicates that the facility is 
probably working correctly; a failure indicates that the facility should be reported 
for maintenance.

To busy verify a telephone:

1. Click Busy Verify.

2. Do one of the following to place a call:

—Press F3 (New). 

—Press ALT and the key (1 to 6) corresponding to an available call 
appearance.

— Click anywhere on the call appearance except the information 
button or comment area.

3. Using the computer keyboard, telephone dialpad, or Hundreds Group 
button and Busy Lamp Field, dial the desired extension.

4. Do one of the following:

— If the call bar shows “INVALID,” and you hear intercept tone, this 
indicates an invalid extension. Press F9 (Release) to release the 
call; then try again.

— If the call bar shows “TERMINATED,” and you hear ringback tone, 
this indicates the called extension is idle and ringing. Verification 
was successful. Talk to the called party, or press F9 (Release) to 
release the call.

— If the call bar shows “BRIDGED,” this indicates your call was 
bridged onto an active call, and initial warning tone was applied to 
the call. Verification was successful. Talk to the bridged parties, or 
press F9 (Release) to release the call.

— If the call bar shows “OUT OF SERVICE” and you hear reorder tone, 
this indicates either a trouble condition at the telephone or a 
telephone that was administered without hardware (not a trouble 
condition). Press F9 (Release) to release the call; then report the 
out-of-service condition to the appropriate personnel.

To busy verify a hunt group:

1. Click Busy Verify.

2. Do one of the following to place a call:

—Press F3 (New). 

—Press ALT and the key (1 to 6) corresponding to an available call 
appearance.

—Click anywhere on the call appearance except the information button 
or comment area.
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3. Using the computer keyboard, telephone dialpad, Hundreds Group button 
and Busy Lamp Field, dial the desired trunk group extension.

— If the call bar shows “INVALID,” and you hear intercept tone, this 
indicates an invalid extension. Press F9 (Release) to release the 
call; then try again.

— If the call bar shows “TERMINATED,” and you hear ringback tone, 
this indicates the called extension is idle and ringing. Verification 
was successful. Talk to the called party, or press F9 (Release) to 
release the call.

— If the call bar shows “ALL MADE BUSY” and you hear reorder tone, 
this indicates that all hunt groups members have activated the Make 
Busy feature. Press F9 (Release) to release the call; then try again 
later.

— If the call bar shows “DENIED” and you hear reorder tone, this 
indicates that all hunt group members are active on a call. 
Press F9 (Release) to release the call; then try again later.

— If the call bar shows “OUT OF SERVICE” and you hear reorder tone, 
this indicates a trouble condition at the hunt group. 
Press F9 (Release) to release the call; then report the out-of-service 
condition to the appropriate personnel.

To busy verify a trunk:

1. Click Busy Verify.

2. Do one of the following to place a call:

—Press F3 (New). 

—Press ALT and the key (1 to 6) corresponding to an available call 
appearance.

—Click anywhere on the call appearance except the information button 
or comment area.

3. Using the computer keyboard or the telephone dialpad, dial the desired 
trunk access code, or click the desired Trunk Group button.

4. Do one of the following:

— If you hear dial tone, go to Step 5.

— If the call bar shows “DENIED,” and you hear intercept tone, this 
indicates an invalid trunk access code or Personal Central Office 
Line (PCOL) trunk group. Press F9 (Release) to release the call; 
then try again.

5. Use the computer keyboard, telephone dialpad, or Hundreds Group button 
and Busy Lamp Field, to dial the desired trunk group member number.
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6. Do one of the following:

— If the call bar shows “INVALID,” and you hear intercept tone, this 
indicates an invalid group member number. Press F9 (Release) to 
release the call; then try again.

— If the call bar shows “VERIFIED,” and you hear confirmation tone, 
this indicates an idle one-way incoming trunk. Verification was 
successful. Press F9 (Release) to release the call.

— If you hear ringback, this indicates an idle automatic tie trunk or idle 
release link trunk. Verification was successful. Press F9 (Release) 
to release the call.

— If you hear dial tone, this indicates the trunk is idle and can be used 
to place a test call. Verification was successful. Place a test call, or 
press F9 (Release) to release the call.

— If the call bar shows “BRIDGED,” this indicates you have been 
bridged onto an active call, and initial warning tone has been applied 
to the call. Verification was successful. Talk to the bridged parties, or 
press F9 (Release) to release the call.

— If the call bar shows “OUT OF SERVICE,” and you hear reorder 
tone, this indicates a trouble condition exists on the trunk. Press F9 
(Release) to release the call; then report the out-of-service condition 
to the appropriate personnel.

DCS Busy Verification of Telephones and 
Remote Trunks

This feature allows you to place test calls to trunks and telephones at a remote 
location within the same DCS network. Busy Verification provides an easy way to 
check the condition of these facilities. When the feature is activated, you can 
distinguish between a telephone or trunk that is truly busy and one that only 
appears busy because of some trouble condition.

The result of a busy verification test may be an intercept tone, a display, or a 
conversation with the called facility. In the following procedures, a successful 
verification tells you that the facility is probably working correctly; a failure tells you 
that the facility should be reported for maintenance.

To busy verify a telephone in a DCS environment:

1. Click Busy Verify.

2. Do one of the following to place a call:

—Press F3 (New). 

—Press ALT and the key (1 to 6) corresponding to an available call 
appearance.

—Click anywhere on the call appearance except the information button 
or comment area.
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3. Using the computer keyboard, telephone dialpad, or Hundreds Group 
button and Busy Lamp Field, dial the desired extension.

4. Do one of the following:

— If you hear intercept tone, this indicates an invalid extension. 
Press F9 (Release) to release the call; then try again.

— If the call bar shows “DENIED,” and you hear reorder tone, this 
indicates a trouble condition that exists on the DCS link.
Press F9 (Release) to release the call; then report the out-of-service 
condition to the appropriate personnel.

— If you hear ringback tone, this indicates that the called extension is 
idle and ringing. Verification was successful. Talk to the called party, 
or press F9 (Release) to release the call.

— If the call is bridged onto an active call, and initial warning tone was 
applied to the call, this indicates verification was successful. Talk to 
the bridged parties, or press F9 (Release) to release the call.

— If you hear reorder tone, this indicates either a trouble condition at 
the telephone, or a terminal that was administered without hardware 
(not an error condition). Press F9 (Release) to release the call, then 
report the out-of-service condition to the appropriate personnel.

To busy verify a remote trunk in a DCS environment (simple verification method):

1. Click Busy Verify.

2. Do one of the following to place a call:

—Press F3 (New). 

—Press ALT and the key (1 to 6) corresponding to an available call 
appearance.

—Click anywhere on the call appearance except the information button 
or comment area.

3. Click the desired Trunk Group button.

4. Do one of the following:

— If you hear dial tone, go to Step 5.

— If you hear intercept tone, this indicates an invalid trunk access code 
or Personal Central Office Line (PCOL) trunk group. Press F9 
(Release) to release the call; then try again.

5. Using the computer keyboard, telephone dialpad, or Hundreds Group 
button and Busy Lamp Field, dial the desired trunk group member number.



Troubleshooting Call Processing System Problems

Issue  1   March 2002 4-13

6. Do one of the following:

— If the call bar shows “DENIED,” and you hear reorder tone, this 
indicates a trouble condition that exists on the DCS link. 
Press F9 (Release) to release the call; then report the out-of-service 
condition to the appropriate personnel.

— If you hear confirmation tone, this indicates an idle one-way 
incoming trunk. Verification was successful. Press F9 (Release) to 
release the call.

— If you hear ringback, this indicates the trunk is an idle automatic tie 
trunk or release link trunk. Verification was successful. Press F9 
(Release) to release the call.

— If you hear dial tone, this indicates the trunk is idle and can be used 
to place a test call. Verification was successful. Place a test call, or 
press F9 (Release) to release the call.

— If the call is bridged onto an active call and initial warning tone was 
applied to the call, this indicates verification was successful. Talk to 
the bridged parties, or press F9 (Release) to release the call.

— If you hear reorder tone, this indicates a trouble condition on
the trunk. Press F9 (Release) to release the call; then report the 
out-of-service condition to the appropriate personnel.

To busy verify a remote trunk in a DCS environment (two-button push verification 
method):

1. Click Busy Verify.

2. Do one of the following to place a call:

—Press F3 (New). 

—Press ALT and the key (1 to 6) corresponding to an available call 
appearance.

—Click anywhere on the call appearance except the information button 
or comment area.

3. Use the computer keyboard or the telephone dialpad to dial the desired 
trunk access code.

4. Click Busy Verify.

5. Do one of the following:

— If you hear dial tone, go to Step 6.

— If you hear intercept tone, this indicates an invalid trunk access code 
or Personal Central Office Line (PCOL) trunk group. Press F9 
(Release) to release the call; then try again.

6. Use the computer keyboard or the telephone dialpad to dial the desired 
trunk access member number.
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7. Do one of the following:

— If the call bar shows “DENIED,” and you hear intercept tone, this 
indicates an invalid trunk access code. Press F9 (Release) to 
release the call; then try again.

— If the call bar shows “DENIED,” and you hear reorder tone, this 
indicates a trouble condition that exists on the DCS link. Press F9 
(Release) to release the call; then report the out-of-service condition 
to the appropriate personnel.

8. Use your keyboard or the telephone dialpad to dial a trunk access member 
number pair.

9. Do one of the following:

— If you hear confirmation tone, this indicates an idle one-way 
incoming trunk. Verification was successful. Press F9 (Release) to 
release from the call.

— If you hear ringback, this indicates the trunk is an idle automatic tie 
trunk or release link trunk. Verification was successful. Press F9 
(Release) to release the call.

— If you hear dial tone, this indicates the trunk is idle and can be used 
to place a test call. Verification was successful. Place a test call, or 
press F9 (Release) to release the call.

— If the call is bridged onto an active call and initial warning tone was 
applied to the call, this indicates verification was successful. Talk to 
the bridged parties, or press F9 (Release) to release the call.

— If you hear reorder tone, this indicates a trouble condition on
the trunk. Press F9 (Release) to release the call; then report the 
out-of-service condition to the appropriate personnel.
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Trunk Group Busy/Warning Indicators to 
Attendant

This feature provides you with a visual indication of the trunk group status for each 
of the Trunk Group buttons displayed on the console.

■ Gray — Indicates normal. Fewer than a predefined number of trunks in the 
associated group are busy.

■ Green — Indicates that a predefined number of trunks in the associated 
trunk group are busy.

■ Red — Indicates that all trunks in the associated trunk group are busy.

Feature buttons can also be administered as Local Trunk Group buttons and 
Remote Trunk Group buttons; for a total of up to twelve more Trunk Group 
buttons. Each of these feature buttons indicates the status of its associated trunk 
group; again by changing to the appropriate display color.

Observe these indicators to stay alert to unusual or suspicious conditions, such as 
groups that are always busy or those that are never busy. Knowing what hours of 
the day are typically the most and least busy will also prove useful in analyzing 
possible trunk problems. For example, if a trunk group remains red for a particular 
group during a period that is not usually busy, it may be that one or more trunks 
are out-of-service but appear to be busy. Another indicator of a possible problem 
situation is the Trunk Group button whose color never seems to change. When 
you notice an unusual situation, use Busy Verification to test the trunk you 
suspect is faulty.

NOTE:
DCS is required for the busy and warning indicators associated with Remote 
Trunk Group buttons, but the buttons themselves will work without DCS.
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Trunk Identification

When a telephone user in the system experiences noise or poor transmission on 
a trunk, the user can conference the attendant into the call. You can then use the 
Trunk Identification feature to identify the specific trunk that is faulty and report it 
for maintenance. The Trunk Identification feature can also be used on trunk calls 
originated by, or received by, the attendant.

The trunk identification (access code and group member number) will be 
displayed when you click the Identify Trunk feature button during a call. If two 
trunks are used for a call, the identification of the last trunk added to the call is 
displayed. Trunk Identification cannot be displayed if more than two trunks are on 
a call.

The following procedure assumes that you are on an active call; however, the 
Identify Trunk feature button can be used while a trunk is being accessed, while 
digits are being outpulsed on a trunk, or during the intervals that occur between 
digit outpulsing.

To identify the specific trunk being used on a call:

1. Click Identify Trunk.

2. Report the trunk problem and all available identification information to the 
call processing system manager or other appropriate maintenance 
personnel.
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GLGlossary

A

Abbreviated Dialing
The Avaya call processing system feature that provides a mechanism for storing and recalling 
numbers used to place calls and activate features. This feature reduces the number of keystrokes 
required for dialing.

AD feature buttons
The administered Abbreviated Dialing feature buttons that allow one-button dialing of selected 
numbers or access to Abbreviated Dialing lists.

Administration Without Hardware (AWOH)
The Avaya call processing system feature that provides the ability to administer station forms with-
out specifying a port location. Such stations are referred to as “phantoms” and do not generate 
alarms and errors when the station is translated but not yet installed.

Alarm Indicator
The indicator that appears at the bottom of the Softconsole window when a call processing system 
problem is detected.

Alarm Reported Indicator
The indicator that appears at the bottom of the Softconsole window that indicates a detected call 
processing system problem was reported to the maintenance organization.

Alerting Timer
The Avaya call processing system feature that terminates a held or unanswered call on a call 
appearance when the call has not been answered within a predefined length of time.

AQI
Attendant Queue Indicator. This Softconsole window component keeps you informed of calls wait-
ing to be answered. Located in the status bar, the AQI shows the number of calls in the queue and 
the number of minutes the oldest call has been waiting. 

Attendant Auto-Manual Splitting
The feature that lets you temporarily disconnect from a caller, place a call to another party, and 
then connect the two parties together.

Attendant Call Waiting
The Avaya call processing system feature that allows a call transferred from the console to a busy 
single-line telephone inside the system to wait at the called telephone.

Attendant Conference
The Avaya call processing system feature that allows you to arrange a conference call with as 
many as five conferees.

Attendant Control of Trunk Group Access
The Avaya call processing system feature that allows you to control access to as many as twelve 
trunk groups, loudspeaker paging zones, or code calling zones per console. Calls from system 
users to the trunk group under attendant control redirect to an attendant console.
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Attendant Direct Trunk Group Selection
The Avaya call processing system feature that allows you to select a trunk group for an outgoing 
call, loudspeaker paging zone, or code calling zone by clicking a Trunk Group button.

Attendant Display
The Avaya call processing system feature that shows call related, personal service, and message 
information on the alphanumeric display of the attendant console. 

Attendant Intrusion
The Avaya call processing system feature that enables you to enter an existing call on either a dig-
ital or analog station to offer a new call or message to the called party.

Attendant Lockout
The Avaya call processing system feature that prevents you from reentering a multiparty call that is 
held on the console unless you are recalled by a system user on the call.

Attendant Override of Diversion Features
The Avaya call processing system feature that allows you to bypass any diversion features invoked 
by and/or associated with a dialed extension.

Attendant Priority Queue
The Avaya call processing system feature used to handle incoming calls to the attendant group or 
to an individual attendant when the call cannot be immediately terminated to an attendant.

Attendant Recall
The Avaya call processing system feature that allows a system user on a two-party call or a confer-
ence call held on the console to call you for assistance.

Attendant Serial Call
The Avaya call processing system feature that allows you to transfer trunk calls that return to the 
same attendant position after the called party hangs up.

Auto Hold
The Avaya call processing system feature that, when enabled, automatically places an active call 
on hold when you select another call appearance button.

Automatic Alternate Routing (AAR)
The Avaya call processing system feature that selects the most preferred route (usually the most 
direct route) for private network calls.

Automatic Answer
The feature that causes incoming calls to be answered automatically, without a mouse click or F3 
button press. This feature can be used only when you are using a headset connected to the con-
sole.

Automatic Circuit Assurance (ACA)
An Avaya call processing system feature used for monitoring possible trunk failures.

Automatic Route Selection (ARS)
The Avaya call processing system feature that selects the most preferred route (usually the least 
expensive route) for long-distance calls.

Auxiliary Work Mode
A mode in which agents are unable to receive ACD calls.
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B

Busy Lamp Fields
The lamps associated with each Hundreds Group button that indicate the status of a group of 
extensions.

Busy Verification of Telephones and Trunks
An Avaya call processing system feature used for placing test calls.

C

call appearance
A component of the Softconsole window that displays information about each phone call that you 
are currently handling. The call appearance includes a call state icon, call timer, text messages 
sent from the call processing system, second party name and notes, an information button, and 
comment area.

Call Coverage
The Avaya call processing system feature that redirects unanswered internal and/or DID calls to an 
alternate answering position.

Call Detail Recording (CDR) Account Code Dialing
The Avaya call processing system feature that collects call details on selected incoming and outgo-
ing trunk calls and creates call records using this information.

Call Forwarding All Calls
The Avaya call processing system feature that allows you to activate and deactivate Call Forward-
ing All Calls for an extension in the system.

Call Handling area
The lower portion of the Softconsole window that displays six “call appearances,” each providing 
information about a phone call that you are currently handling.

Call Park
The Avaya call processing system feature that allows an incoming call to be put on hold at an 
extension, then retrieved from any telephone in the system.

call processing system
A telecommunications system that routes voice and data information between various end points 
(for example, telephones, terminals, and computers). It provides highly robust networking capabili-
ties and includes an extensive set of standard features. 

Call Purpose Identifier
Text (if available) displayed on the call appearance to indicate a call was directed, redirected, or 
returned to the console.

call timer
When you answer a call (or the Softconsole Auto Answer feature answers a call), the call timer is 
displayed on the left side of the call appearance. The timer shows the call’s duration.

Called Party Identification
The display that indicates who is being called. For calls to a system user, the display shows the 
digits as they are dialed. After the dialing is complete, the display shows the called party’s name (if 
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available) and extension number. On outgoing trunk calls the display shows the digits as they are 
dialed, followed by the name and trunk access code assigned to the trunk group being used.

Calling Party Identification
The display that indicates who is calling. When the call is from a system user, the display shows 
the caller’s name or a unique identification administered for the telephone being used, along with 
the calling party’s extension number. When the call is from outside the system, the display shows 
the trunk identification, such as CHICAGO and the trunk access code assigned to the trunk group 
used for the call.

Centralized Attendant Service (CAS)
The feature that allows system users served by separate call processing systems at two or more 
locations to concentrate the attendant positions at one location. This location is called the CAS 
main. The other locations, typically without attendants, are called CAS branches.

Class of Restriction (COR)
The Avaya call processing system feature that defines multiple classes of call origination and ter-
mination privileges. Systems may have only a single COR, one with no restrictions, or multiple 
CORs to implement the desired restrictions.

Class of Restriction Identifiers
All system users have a Class of Restriction (COR) to define their calling privileges. The COR is a 
two-digit number, followed by a four-character identifier. You must click the COR feature button to 
display a user’s COR. The COR information can be obtained from your call processing system 
administrator.

Class of Service (COS)
The Avaya call processing system feature that defines whether telephone users have access to the 
following features: Automatic Callback, Call Forwarding All Calls, Client Room, Console Permis-
sion, Data Privacy, Off-Hook Alert, and Priority Calling.

Clocked Manual Override Option
The Time-of-Day-Routing option that allows you to specify the day and time to override the sched-
uled Time-of-Day Routing plan. You can also specify a day and time for automatic deactivation, or 
manually deactivate Clocked Manual Override.

Code Calling Access
The Avaya call processing system feature that allows you to page a called party with coded chime 
signals in up to nine areas (zones).

comment area
An area to the right of the call appearance that allows you to enter comments while you are active 
on a call. These comments remain for the duration of the call only.

COM Port
The port on the back of the Softconsole computer to which the telephone or CallMaster VI must be 
physically connected in Digital Communications Protocol installations.

Companding
For Digital Communications Protocol installations, the option that determines whether the system 
will digitize voice signals according to the accepted Mu-Law or A-Law standards.

Console administration
The procedures that the Softconsole administrator uses to define your environment. This responsi-
bility includes creating directories that you can access via Softconsole, identifying the users who 
are authorized to access Softconsole, and specifying how the buttons are configured at the call 
processing system by configuring them the same way within the Softconsole software
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Console Alarm Indicators
The built-in alarm lamps that indicate major and minor troubles on the Avaya call processing sys-
tem. Feature buttons on the console can also be administered as alarm indicators to identify more 
specific problem conditions.

Consult
The Avaya call processing system feature option that allows you to talk with the called party after 
you answer a redirected call.

Controlled Restrictions
The Avaya call processing system feature that allows you to activate or deactivate the restrictions 
for individual telephones or groups of telephones (on a COR basis).

Coverage Callback
The Avaya call processing system feature that allows you to leave a callback message for the 
called party after you answer the redirected call.

D

Direct Department Calling (DDC)
An Avaya call processing system feature that allows direct inward access to an answering group 
other than the attendant even if the system does not have the DID feature.

Direct Inward Dialing (DID)
The Avaya call processing system feature that connects calls from the public network directly to 
the dialed extension without assistance from you.

Directory administration
The procedures that the Softconsole administrator uses to define, and later identify, the database 
information required by Softconsole to communicate with the call processing system.

display buttons
The administered buttons that access a display function. Click the button to perform the associated 
task. The display buttons required on every Softconsole are Normal and Next.

Distributed Communications Protocol (DCP)
A specific type of communications protocol used by the Avaya call processing system associated 
with Softconsole. When this protocol is used, additional hardware (such as the CallMaster VI) is 
required to connect the Softconsole computer, the telephone, and the call processing system.

Distributed Communications Service (DCS)
A configuration of 2 to 20 private call processing systems that are interconnected. These systems 
may be in different geographic locations.

Diversion features
Any call processing system features which, when activated, cause the call to alert to a point differ-
ent from the dialed station.

Don’t Split
The Avaya call processing system feature that temporarily disables Auto Start, and sends DTMF.
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DXS/BLF
Direct Extension Select/Busy Lamp Field. A Softconsole window component consisting of “tabs.” 
Each tab contains a grid of 100 cells that correspond to administered extensions in the call pro-
cessing system. Each cell can display information about a single extension and can be selected to 
dial the associated extension number.

E

Emergency Access to the Attendant
The Avaya call processing system feature that provides for emergency calls to be placed to you 
automatically by the system, or dialed by system users; and allows such calls to receive priority 
handling.

Emergency feature button
The administered feature button that turns pink when an emergency call is placed to you.

F

Facility Busy Indication
The Avaya call processing system feature that provides a visible indication of the active/busy sta-
tus of a particular trunk group or extension.

Facility Test Call
The Avaya call processing system feature that allows authorized personnel to place test calls to 
specific trunks, touch-tone receivers, time slots, and system tones.

feature buttons
The administered buttons that access an Avaya call processing system feature. Click the button to 
perform the associated task. The feature buttons required on every Softconsole are Split, Hold, 
Forced Release, Position Busy, and Night Service.

H

hold timer
When a call is on hold, the hold timer on the call appearance displays the number of minutes and 
seconds the call in on hold. 

hot key
A keyboard accelerator (that is, a key combination such as ALT-D) that allows you to access partic-
ular Softconsole features or directories or to perform certain tasks quickly. Hot keys are pro-
grammed by your Softconsole administrator.

Hundreds Group button
The administered button that allows you to access up to 100 extensions.

hunt groups
A group of extensions that is assigned the Station Hunting feature so that a call to a busy extension 
will reroute to an idle extension in the group.
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I

Immediate Manual Override Option
The Time-of-Day-Routing option that immediately changes the active routing plan to a new plan.

Individual Attendant Access
The Avaya call processing system feature that allows users to access a specific attendant console 
by directly dialing the attendant’s extension number.

Integrated Directory
The Avaya call processing system feature that enables you to retrieve extension numbers from the 
system directory. It is one of several directories that your Softconsole administrator can make avail-
able to you.

Inter-PBX Attendant Service (IAS)
The Avaya call processing system feature that allows attendant positions for more than one branch 
location to be concentrated at one central location.

ISDN-PRI
The Avaya call processing system feature that provides additional information to be displayed on 
the console.

L

LAN
A networking arrangement designed for a limited geographic area.

Leave Word Calling
The Avaya call processing system feature that allows you to leave messages for system users.

Local Trunk Group buttons 
Administered feature buttons that allow you access to local trunk groups on the system.

Loudspeaker Paging Access
The Avaya call processing system feature that allows you to access loudspeaker paging equip-
ment.

Loudspeaker Paging Access-Deluxe
The Avaya call processing system feature that allows you to access loudspeaker paging equip-
ment and park calls with the activation of only one feature.

M

Make Busy
The Avaya call processing system feature that temporarily removes the console from the hunt 
group.

Message Retrieval
The Avaya call processing system feature that allows you to retrieve messages for other system 
users.
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More Information button
A button labeled “i” on the call appearance. You can click on this button (or press ALT-I) to open a 
read-only dialog box containing the available information (if any) for the second party display fields.

N

Network Access-Private
The Avaya call processing system feature that allows calls to be connected to networks such as 
Common Control Switching Arrangement (CCSA), Electronic Tandem Network (ETN), and 
Enhanced Private Switched Communications Service (EPSCS).

Network Access-Public
For outgoing calls to the public network, the ARS feature (if available) can be used to select the 
best route available at the time the call is placed. For manual route selection, dial access codes 
can be assigned to outgoing routes.

Night Service
The Avaya call processing system feature that directs all attendant group calls for the principal and 
daytime attendant console to a night console.

Night Service Disconnect Timer
The timer that determines how long an incoming call without disconnect supervision can go unan-
swered at a night service destination when the call processing system is in night service.

Night Station Service
The Avaya call processing system feature that redirects incoming attendant-seeking trunk calls to 
designated extensions whenever the system is placed in Night Service.

No Answer Timer
The Timing feature that increments a delay threshold count when a call to the attendant has not 
been answered within a predefined length of time.

Notepad
If the Notes field is administered for the Softconsole directory, you can make notes related to a 
specific directory entry. These notes may contain information about the individual’s vacation or 
travel status, about the hours when this person can be reached, and so forth. The information is 
saved with the associated directory entry until it is overwritten or deleted by you or another atten-
dant.

P

Party
A general term for individuals who are placing or receiving calls at call processing system exten-
sions or external telephones.

Pickup Indicator
A heavy border that outlines the call appearance associated with a call that will be answered when 
you press F4 or click on the Pickup button.
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Position Available
A state, indicated by a console lamp, in which the console is ready to receive a call (that is, no calls 
appear on the console, the Position Busy button is not turned on, and a Day-only console in not in 
Night Service Mode).

R

Remote Hold
A feature used by CAS attendants that allows a call to be held at the branch location

remote maintenance site
A remote site to which system alarms are sent automatically.

Remote Trunk Group buttons
Administered feature buttons that allow the attendant access to remote trunk groups on the sys-
tem.

Return Call Timeout
The Timing switch feature that sends a special ringing tone to the attendant when a transferred call 
has not been answered within a preset length of time, and has returned to the console.

S

Second Party Display
The area beneath the Call Handling appearances that displays information about the called or call-
ing party for the currently active call.

Straightforward Outward Completion
The Avaya call processing system feature that allows the attendant to complete an outgoing trunk 
call for a telephone user, by selecting a trunk and dialing the outside number.

system alarms
Alarms that are generated by the Avaya call processing system and produce visible signals at the 
console, at selected telephones, and at the system equipment cabinet.

T

Through Dialing
The Avaya call processing system feature that allows you to select an outgoing trunk for a tele-
phone user, release the call, and permits the user to dial the remainder of the number.

Time-of-Day Routing
The Avaya call processing system feature that allows outgoing calls to be placed over the most 
economical route, based on the time of day and day of week.

Timed Reminder
The Timing feature that sends a special ringing tone to you if a call that has been on hold at the 
console for longer than a predefined maximum needs attention, or if an extended call not answered 
within a predefined time period has returned to the console.
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Trunk Answer From Any Station (TAAS)
An Avaya call processing system feature that allows a station user to dial an access code an 
answer calls that are usually directed to you.

Trunk Group Busy/Warning Indicators to Attendant
The Avaya call processing system feature used to provide an indication of trunk usage.

Trunk Group buttons
The administered buttons that allow you to select an outgoing trunk group. They can also be used 
to select a code-calling or loudspeaker paging zone.

Trunk Identification
The Avaya call processing system feature used to specifically identify the trunk where a problem is 
occurring.

Trunk-to-Trunk Transfer
The Avaya call processing system feature that allows you to originate two outgoing trunk calls and 
connect them.

U

Uniform Call Distribution (UCD)
A Avaya call processing system feature that allows direct inward access to an answering group 
other than the attendant even if the system does not have the DID feature.

V

Visually Impaired Attendant Service (VIAS)
The Avaya call processing system that provides voiced feedback to the visually impaired atten-
dant.
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area codes, 4-4
Attendant Auto-Manual Splitting, 3-14
Attendant Conference, 3-5
Attendant control, 1-11
Attendant Direct Trunk Group Selection, 3-23
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Busy Lamp Field display, 1-9
Busy Verification feature, 4-7, 4-8
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call appearance, 1-9
comment area, 1-10, 3-26
resizing, 1-14

Call Handling area, 1-9
call handling button problems

troubleshooting, 4-3
call handling functions

overview, 3-1
call handling methods, 3-2
call processing system

troubleshooting, 4-5
call timer, 1-10
Call Waiting Warning lamp, 1-12
CallMaster VI

volume adjustment, 1-15
CallMaster VI telephone

troubleshooting, 4-2
calls
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holding, 3-7
placing, 3-10
placing external, 3-12
releasing, 3-14
transfer types, 3-15

CAS calls, 1-3, 3-23
branches, 3-24
originating branch, 3-23

CAS system environment, 1-3, 3-5, 3-14
Busy Lamp Fields, 3-23
conference feature, 3-5
Remote Hold, 3-8
returning calls, 3-25
splitting calls, 3-14
transfer calls, 3-23

CDR 1 Failure-In feature button, 4-6
CDR 2 Failure-In feature button, 4-6
Code Calling Access, 3-23
comment area, 1-10
comments

entering, 3-26
conference call

CAS environment, 3-5
ending, 3-6
Hold feature, 3-7
number of participants, 3-5
removing yourself, 3-5

Conference feature, 3-2
Coverage Point, 1-15
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D

DCS Busy Verification feature, 4-7, 4-11
DCS system environment, 1-2

Busy Verification, 4-11
Debug feature, 1-6
default directory, 1-8
dialing rules, 1-6, 4-4
dialpad, 1-14
directories

adding an entry, 2-4
deleting entries, 2-5
detailed record, 2-6
making calls, 2-3
making notes, 2-5
modifying entries, 2-4
overview, 2-1
searching, 2-2
selecting, 2-2
sending email, 2-7
typedown search, 2-3
viewing, 2-6
viewing line status, 2-7

Directory display area, 1-8
Directory feature, 3-23

troubleshooting, 4-4
Directory functions, 2-1
Directory menu, 1-7
display buttons, 1-11
Display control toolbar, 1-11
Display menu, 1-7
Display text box, 1-12

disabling, 1-14
Drop All button, 3-2, 3-6
DXS/BLF

hiding, 1-14
resizing, 1-14

DXS/BLF display, 1-9
DXS/BLF feature, 3-27

directory record access, 3-27
transfer calls, 3-17

E

email feature, 2-7
emergency call, 3-4
Emergency feature button, 3-4
exiting, 1-21
external call, 3-12
external number

transferring calls, 3-19

F

Facility Busy Indication, 3-23
feature button problems

troubleshooting, 4-3
feature buttons, 1-11
Features menu, 1-7
File menu, 1-6
Forced Release feature button, 3-6, 3-15

H

hardware alarm indicators, 4-6
held call

making comments, 3-7
retrieving, 3-8

Help menu, 1-7
Help tip, 1-11
Hold feature, 3-7
hot keys, 1-13, 3-2
Hundreds Group button, 3-23

I

iClarity IP Audio, 4-2
Identify Trunk feature button, 4-16
incoming call, 3-3
incoming trunk call, 3-21
Individual Calls indicator, 1-12
IP configurations

IP Login, 1-20
logging off, 1-21
troubleshooting, 4-2
volume control, 1-15

IP Login option, 1-6

K

keyboard accelerators, 3-2
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L

line status, 2-7
Link down indicator, 1-12
Link Failure feature button, 4-6
Local Trunk Group buttons, 4-15
Login dialog box, 1-19
Logoff, 1-6
Loudspeaker Paging Access, 3-23

M

Major Alarm feature button, 4-6
menu bar, 1-6
More Information button, 1-10, 3-27

N

Next button, 1-11
Notes field, 2-5

O

Originator, 1-15
overview, 1-1

P

password, 1-19
PC Console, 3-2, 3-6
Pickup indicator, 3-3
placing, 3-12
placing calls, 3-12
playback devices, 1-7
PMS Link Failure feature button, 4-6
PMS Printer Alarm feature button, 4-6
Position Available indicator, 1-12
Postion Busy Lamp

troubleshooting, 4-2

R

recording devices, 1-7
Release Line Trunks (RLTs), 1-3
releasing calls, 3-14
Remote Hold, 3-8
Remote Hold call

answering, 3-9
Remote Trunk Group buttons, 4-15
restore default view, 1-7, 1-14
RLT, 1-3

S

searching, 2-2
Second Party Display, 1-8, 1-10
Second Party Display Handling, 1-6, 1-15
Second Party information

More Information button, 3-27
Shortcut keys, 1-13
Show details option, 2-6
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accessing, 1-19
call handling functions, 3-1
customizing, 1-14
Display menu, 1-7
Features menu, 1-7
password, 1-19
slow response, 4-3
troubleshooting, 4-1
Trunks menu, 1-7
user identification, 1-19

Softconsole directories, 2-2
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adding an entry, 2-4
deleting entries, 2-5
making calls, 2-3
modifying entries, 2-4
Notes field, 2-5
sending email, 2-7
Show details option, 2-6
View option, 2-6
viewing line status, 2-7

Softconsole Directory
overview, 2-1

Softconsole session, 1-21
starting, 1-19
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Softconsole window, 1-4, 1-7, 1-9, 1-10
Action toolbar, 1-10
call appearances, 1-9
components, 1-5, 1-10
Directory display areas, 1-8
display buttons, 1-11
feature buttons, 1-11
resizing, 1-14
restoring default view, 1-14
Status bar, 1-12
Trunk buttons, 1-11

speakerphone
troubleshooting, 4-2

speed dial button, 2-6
Split feature button, 3-14, 3-21, 3-22
standard appearance, 1-4
Status bar, 1-12
status bar

alarm indicators, 4-5
status lamps, 1-12
supervised transfer, 3-15
system settings, 1-15
System Settings option, 1-6

Auto Transfer, 1-15
Second Party Display, 1-15

T

TAPI Configuration option, 1-6, 4-4
telephone problems

troubleshooting, 4-2
temporary comments, 3-26
timed reminder interval, 3-7
toolbars

resizing, 1-14
transfer

supervised, 3-15
unsupervised, 3-15

transferring calls
announced, 3-17
Auto Transfer, 3-16
supervised, 3-17

troubleshooting, 4-1, 4-2
trunk access code, 3-12
Trunk buttons, 1-11
Trunk Group Busy/Warning indicators, 4-7, 4-15
Trunk Group in use, 1-11
Trunk Group Select button, 3-12

transfer calls, 3-20

trunk group status, 4-15
Trunk Group warning, 1-11
trunk identification, 4-16
Trunk Identification feature, 4-7
trunk status indicators, 1-11
Trunks menu, 1-7
Trunk-to-Trunk Transfer feature, 3-21
Tuning Wizard, 1-15
typedown search, 2-3

U

unsupervised transfer, 3-15
user password, 1-19
user profile, 1-19

V

View menu, 1-6
Audio control options, 1-15
Restore default view option, 1-14
System Settings option, 1-15

View option, 2-6
volume adjustment, 1-15
volume control, 1-7
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